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Welcome!

 

Thank you for purchasing Reason 2.5!

Version 2.5 is the second major update of Reason, complementing the set of de-
vices in the rack with world class effects. With these additions we now feel com-
pletely confident saying that we deliver a music production instrument that 
surpasses anything created before it. We'd even like to go as far as to say that 
Reason has already changed the way many people think about making music 
with computers. And while we feel that this update in many ways makes the ap-
plication complete, we certainly haven't run out of ideas for future additions!

A strong driving force for us at “PropellerHeadQuarters” is the communication 
with all the people around the world that use our applications for expressing 
themselves. One meeting point for all of us is the song archives and message 
boards on our web pages. This is a unique forum where professionals and be-
ginners meet on equal terms to exchange music and ideas. Even more impor-
tantly, it’s a forum open to you! Share your experiences by communicating with 
us and others and by uploading your songs for others to hear. We think you will 
appreciate the feedback from other Reason users all over the world, just as 
much as we appreciate the feedback we get from you. So, see you on the Pro-
pellerhead web!

Yours truly,

The Propellerhead Software Team

www.propellerheads.se

 

About the manuals

 

This is the Getting Started manual, covering the basic features and procedures 
in Reason. It also contains a tutorial section and a guided tour, to help you get 
going with the program. 

The more advanced features in Reason are described in the electronic docu-
mentation, a file in Adobe Acrobat (“.pdf”) format which is installed with the pro-
gram. In that document you will also find reference descriptions of the Reason 
devices and commands.

 

!

 

To read the electronic documentation you will need the Adobe Ac-
robat Reader application (version 4.0 or later). Since this has be-
come something of a household utility application, chances are you 
already have it installed on your computer. If not, run the Acrobat 
Reader installer included on the Reason program disc. For Mac OS 
users, please note that the CD contains two different Adobe Acro-
bat Reader installers - one for MacOS 9.x and one for MacOS X, so 
make sure to select the correct one for your operating system.

 

About Mac and Windows

 

Reason runs under MacOS and Windows (for operating system details, see be-
low). All Reason packages contain program versions for both platforms. Every-
thing said in the manuals applies to both platforms, unless explicitly stated.

If you are running Mac OS X, please note that there’s an additional menu called 
the Reason menu, which is not present under other operating systems. This con-
tains the Preferences menu item (otherwise found on the Edit menu).

 

!

 

Virtually all screenshots in the manuals are from the Windows ver-
sion of Reason. However, the contents of all windows and dialogs 
are the same on both platforms.
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What is in the Reason 
package?

 

When you purchase Reason, the package contains the following items:

 

D

 

The Program Disc CD.

 

This contains the Reason installer, OMS installer (Mac OS 9 only), elec-
tronic documentation in Adobe Acrobat format, and an installer for Adobe 
Acrobat Reader. There will also be additional files such as promotional ma-
terial, demo versions of other Propellerhead Software products, etc.

 

D

 

The Factory Sound Bank CD.

 

This contains the Reason Factory Sound Bank, a large file containing sam-
ples, patches and loops for use with Reason. You may choose to install this 
file on your hard disk, so that the CD isn’t required when you run the pro-
gram (more on this on page 10).

 

D

 

The Orkester CD

 

This contains the Reason Orkester Sound Bank. Just like with the Factory 
Sound Bank described above, you can choose to install this on your hard 
disk, eliminating the need for the CD when using sounds from the Orkester 
Sound Bank (see page 10 for more information).

 

D

 

The printed documentation.

 

D

 

The product authorization card.

 

This contains the license number required for the installation. Keep this card 
in a safe place, in case you need to re-install Reason!

 

Requirements

 

Below you will find the minimum requirements for running Reason:

 

!

 

Note that these are the minimum requirements! You will benefit 
from a fast computer with a lot of RAM, since this will allow you to 
use more devices at the same time.

 

Mac OS X

 

• Any computer that runs Mac OS X version 10.1 or later.
• A MIDI interface and a MIDI keyboard (or similar).

 

Mac OS 9

 

• Power Macintosh with 604, 604e, G3 or G4 processor or better (see the 
note below). 166 MHz or faster.

• 128 Megabytes of RAM.
• CD-ROM drive.
• Mac OS 9.0.4 or later.
• 256 color monitor (or better), 800x600 or larger.
• A MIDI interface and a MIDI keyboard (or similar).
• OMS 2.x or later (included). 

 

!

 

Reason takes advantage of the Altivec (Velocity Engine) instruc-
tions used in the Macintosh G4 processors, which enhance perfor-
mance.

 

!

 

Please observe that Virtual Memory 

 

must

 

 be deactivated under Mac 
OS 9.x. With Virtual Memory activated, it will not be possible to run 
Reason at all!

 

Windows

 

• Intel Pentium 2 or better. 233 MHz or faster.
• 64 Megabytes of RAM.
• CD-ROM drive.
• Windows 98, ME, 2000 or XP (or later).
• 256 color monitor (or better), 800x600 or larger.
• A 16 bit Windows compatible audio card, preferably with an ASIO or Di-

rectX driver. Microsoft DirectX (only if the card supports it).
• A MIDI interface and a MIDI keyboard (or similar).
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About the Audio 
Hardware

 

The audio hardware is the computer equipment that converts the digital signals 
from Reason to analog audio signals (for connection to an amplifier, head-
phones, or similar). This equipment could be a standard stereo sound card, the 
built-in audio hardware on a Macintosh or some more advanced audio card with 
several inputs and outputs, digital connectors, etc. Regardless of which, you 
need to make sure the hardware and its drivers are properly installed:

 

Mac OS X

 

If you are using the built-in audio hardware of the Macintosh

 

In this case you don’t need to make any extra settings. Just connect the audio 
output to your listening equipment (speakers, mixer, headphones or similar) and 
make sure your Mac plays audio properly.

 

If you are using other audio hardware

 

You may want to use other audio hardware with Reason (e.g. an audio card with 
multiple outputs, digital connections, etc.). For this to be possible, the audio 
hardware must be compatible with Mac OS X, that is, there must be a Mac OS 
X driver available for the card.

 

2. Install the audio hardware and its drivers as described in its docu-
mentation.

3. Connect the stereo outputs of your audio hardware to your listening 
equipment (speakers, mixer, headphones or similar).

 

For info about how to use multiple outputs (i.e. more than a stereo output), 
see the electronic documentation. For now, we stick to standard stereo con-
nections.

 

4. If possible, test that audio plays back OK with the audio hardware.

 

With some audio hardware, a test application is supplied for this purpose.

 

Mac OS 9

 

If you are using the built-in audio hardware of the Macintosh

 

In this case you don’t need to make any extra settings. Just connect the audio 
output to your listening equipment (speakers, mixer, headphones or similar) and 
make sure your Mac plays audio properly, e.g. by testing the alert sounds in the 
Sound control panel (or the “Monitors and Sound” control panel, depending on 
the Mac OS version).

 

If you are using other audio hardware

 

You may want to use other audio hardware with Reason (e.g. an audio card with 
multiple outputs, digital connections, etc.). For this to be possible, the audio 
hardware must be compatible with the ASIO standard. That is, it must have an 
ASIO driver, a piece of software that allows Reason to communicate with the 
card.

 

1. Make sure you have the latest drivers for the audio hardware! 

 

Please check the manufacturer’s web site for the latest versions.

 

2. Install the audio hardware and its low level drivers as described in 
its documentation.

3. Connect the stereo outputs of your audio hardware to your listening 
equipment (speakers, mixer, headphones or similar).

 

For info about how to use multiple outputs (i.e. more than a stereo output), 
see the electronic documentation. For now, we stick to standard stereo con-
nections.

 

4. If possible, test that audio plays back OK with the audio hardware.

 

With some audio hardware, a test application is supplied for this purpose.

 

5. Locate the ASIO driver for the hardware.

 

After installing Reason, you will need to copy this into Reason’s ASIO driver 
folder (see page 10).

 

!

 

Some Macintosh audio hardware comes with a Sound Manager 
driver (i.e. without an ASIO driver). However, we recommend using 
ASIO compatible audio hardware only.
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Windows

 

D

 

If possible, you should use ASIO compatible audio hardware (i.e. 
audio hardware for which there is an ASIO driver).

 

ASIO drivers generally provide better performance and lower latency (see 
page 16).

 

D

 

If there is no ASIO driver available, you should make sure your au-
dio card supports DirectX.

 

DirectX is a Microsoft protocol for handling audio and other multimedia as-
pects.

 

D

 

As a last resort, you could use audio cards that don’t support ASIO 
or DirectX, provided that they are Windows compatible.

 

In this case, Reason will communicate with the audio hardware via MME 
(Windows Multi Media Extensions). However, most often this results in large 
latency values (see page 16), making real-time playback of instrument de-
vices difficult or even impossible.

Regardless of which type of audio hardware or drivers you are using, you should 
follow these basic steps:

 

1. Make sure you have the latest drivers for the audio hardware! 

 

Please check the manufacturer’s web site for the latest versions.

 

2. Install the audio hardware and its drivers as described in its docu-
mentation.

3. Connect the stereo outputs of your audio hardware to your listening 
equipment (speakers, mixer, headphones or similar).

 

For information about how to use multiple outputs (i.e. more than a stereo 
output), see the electronic documentation. For now, we stick to standard 
stereo connections.

 

4. If possible, test that audio plays back properly with the audio hard-
ware.

 

In the case of audio hardware with ASIO drivers, you will need some test ap-
plication for this (often included with the audio hardware). If you are using Di-
rectX or MME drivers, you can use Windows’ Media Player application for 
this.

 

About MIDI Interfaces

 

While it is possible to use Reason without an external MIDI controller (by playing 
patterns and loops only, or drawing notes and automation in the sequencer), this 
would not allow you to use the program to its full potential. From now on we as-
sume that you are using a MIDI interface and some kind of external MIDI control-
ler (typically a MIDI keyboard).

 

D

 

When installing the MIDI interface and its drivers, follow the in-
structions in its documentation carefully.

 

D

 

While a MIDI interface with a single input is sufficient, you will 
benefit from having two or more individual inputs.

 

This is especially true if you want to manipulate Reason parameters with ex-
ternal MIDI control devices or use the program in conjunction with an exter-
nal, stand-alone sequencer, groove machine or similar.

 

Mac OS X

 

• For some MIDI interfaces connected via USB, no driver installation is re-
quired. Just plug in the interface and you’re ready to go!

• For other, more advanced MIDI interfaces (or at least to take advantage of 
more advanced features, like multiple inputs) you will need to install a driver. 
Please consult the documentation that came with the interface for details.

 

Mac OS 9

 

Reason makes use of OMS (Open Music System), a common protocol for MIDI 
communication on the Macintosh. This means that your MIDI interface must sup-
port OMS, and you need to have OMS installed on your computer. 

If OMS isn’t already installed, you need to do this before using Reason. This may 
also be necessary if you have an older version of OMS installed (please check 
the MIDI interface documentation for any special restrictions regarding OMS 
versions). Proceed as follows:

 

1. Insert the Reason program disc into your CD-ROM drive.

2. Locate and double click the file “Install OMS” in the OMS folder on 
the program disc.

3. Follow the instructions on screen.

4. Use the OMS Setup application to set up your MIDI interface.

 

This is necessary to inform the system about the existence, connections and 
settings of the MIDI interface. Usually, how to do this is described in the 
MIDI interface documentation - if not, check the OMS documentation for the 
general procedure.
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✪

 

OMS includes a special feature called IAC (Inter Application Com-
munication) that allows you to route MIDI between programs on 
your computer. If you want to install this feature you must choose 
the custom installation feature in the OMS installer and specifically 
specify that you want IAC installed.

 

Windows

 

Under Windows no special installation procedure is required, just install the 
MIDI interface and its drivers as described in the documentation that came with 
the hardware.

 

MIDI Connections

 

Connect a MIDI cable from the MIDI Out on your MIDI keyboard (or other MIDI 
controller) to a MIDI In on your MIDI interface. This is sufficient to be able to play 
and record notes and controllers in Reason from the MIDI keyboard. If you have 
a MIDI interface with more than one input, it is possible to make more advanced 
MIDI connections - this is described in the electronic documentation.

 

Upgrading vs. New 
Installations

 

If you are upgrading from a previous version, please note the following:

 

D

 

Our recommendation is that you uninstall the previous version be-
fore installing the new one.

 

Under Windows, please use the Uninstall feature. Under Mac OS, just drag 
the program files to the Trash. Uninstalling will ensure that there is no confu-
sion between versions and that shortcuts and aliases point to the right files 
etc. However...

 

D

 

If you install the new version into the same folder as the previous 
version, the old version will automatically be overwritten.

 

 The installer is designed to replace older versions gracefully, but it assumes 
you are then installing into the same folder.

In either case, you will need to redo your Preference settings.

 

D

 

Installing into a new folder.

 

This will preserve your older files and you may be able to run the older ver-
sion of the program if required. However, Start menu items, aliases and 
shortcuts will point to the newer version.

 

Installing the Software

 

Running the Installer

 

Now it’s time to install the actual Reason software:

 

1. Insert the Reason CD labeled “Program Disc” into your CD-ROM 
drive.

2. On the CD-ROM, locate the file called “Install Reason” and double 
click on it.

 

Under Windows, the installer may automatically start when you insert the 
CD, depending on your system settings.

 

!

 

Mac OS note: Please observe that there are two separate installers 
- one for Mac OS 9 and one for Mac OS X. Please make sure that 
you use the correct one.

3. Follow the instructions on screen.

 

About Installing the Sound Banks

 

During installation, you will be asked whether you want to install the Reason Fac-
tory Sound Bank and the Orkester Sound Bank, or not. These each consist of 
one big file, containing a large number of patches, samples and loops, serving 
as your main supply of sounds (much like the sound ROM in a synthesizer).

 

D

 

If you choose not to install the Factory Sound Bank, you will need 
to insert the “Factory Sound Bank” CD into the CD-drive each time 
you run the program.

 

D

 

You may choose not to install the Orkester Sound Bank. Unlike the 
Factory Sound Bank, this does 

 

not

 

 mean you have to insert the 
“Orkester” CD into the CD-drive each time you run the program. It 
merely means that you will have to do so each time you want to use 
a patch or other sound from it.

 

Installing on hard disk is the recommended option, since you will most likely be 
using the sound banks a lot and access is quicker from the hard disk than from 
the CD-ROM drive.

You may chose not to install and instead access the files from CD if you are 
short on hard disk space, if you are running Reason “temporarily” on another 
computer, etc. The drawback is that you will have to swap CDs when you want 
to browse for patches etc.

Even if you don’t install any of the sound banks when you install Reason, you can 
do this at a later stage if you like: simply copy the file “Factory Sound Bank.rfl” 
and/or the file “Orkester.rfl” from the respective Sound Bank CD to the Reason 
program folder.
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Launching the Program

 

Now, the Reason files have been installed in a folder on your hard disk. Under 
Windows, all Reason related items have also been added to the Start menu and 
possibly you will have a Reason shortcut on the Desktop.

 

1. Check for any ReadMe files in the Reason folder or on the Start 
menu, and open and read these.

 

ReadMe files may contain important last minute information that didn’t make 
it into this manual.

 

2. If you are using Mac OS 9 with audio hardware for which there is an 
ASIO driver, copy the ASIO driver into the folder “ASIO Drivers” 
within the Reason program folder.

 

This makes the ASIO driver available to Reason.

 

3. Launch the program by double clicking the Reason icon (or by se-
lecting the Reason item from the Start menu).

4. Insert the Orkester CD in your CD-ROM drive.

 

Regardless of whether you chose to install it on your hard disk or not, this 
CD will be requested for verification the very first time you start Reason.

 

5. Next, you will be asked to insert the “Factory Sound Bank” CD in 
your CD-ROM drive.

 

Again, this is required the very first time you launch Reason, regardless of 
whether you have chosen to install the sound bank on your hard disk or not.

 

6. Fill in the authorization form that appears.

 

Your license number can be found on the product authorization card in-
cluded in the package.

At this point a dialog appears, asking you whether you want to register your copy 
of the program at the Propellerhead web site. Registering gives you immediate 
access to various benefits such as free, extra sounds for Reason!

 

!

 

You must have a working Internet connection to be able to register 
on-line.

 

D

 

If you click the Register Now button, your Internet browser will 
launch and take you to the registration page on the Propellerhead 
web site.

 

Follow the instructions on the web page. After finishing the registration, click 
the Continue button in the installation dialog.

 

D

 

If you don’t want to register at this point, click the Later button.

 

You can register at any time by selecting Product Registration from the Con-
tact menu (Mac) or Help menu (Windows) in Reason (or by going to 
www.propellerhead.se/register).

This completes the installation! Before you can use the program, you need to 
make some settings - this is described in the next chapter.
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About this Chapter

 

This chapter describes the settings you need to make before you can start using 
Reason. These are necessary in order to get any sounds from the program and 
to be able to play and control Reason via MIDI.

 

About the Preferences

 

The basic settings for audio and MIDI are done in the Preferences dialog. This is 
opened from the Edit menu (or, if you are running Mac OS X, from the Reason 
menu).

 

D

 

If you are using Reason for Windows, the Preferences dialog will 
automatically appear the very first time you launch the program.

 

The Preferences dialog.

 

✪

 

Described herein are only the most important settings in the Prefer-
ences. For information about other Preferences settings, see the 
electronic documentation.

 

Setting up the Audio 
Hardware

 

The first thing you need to do is to establish a connection between Reason and 
the audio hardware. This is done by selecting a driver - a software component 
that acts like a link between the program and the audio hardware. Proceed as 
follows:

 

1. In the Preferences dialog, use the pop-up menu at the top to select 
the Audio page.

2. Pull down the Audio Card Driver pop-up menu and select one of the 
options.

 

Which option to select depends on the platform and the audio hardware. If 
an option is not applicable to your setup it will be greyed out in the dialog.
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Mac OS X

 

D

 

Normally, you should select one of the driver options that start with 
the word “CoreAudio”.

 

Select the option that corresponds to the hardware you want to use (the 
built-in audio connectors or some additional audio hardware that you have 
installed).

 

D

 

Other options may be available, mainly for compatibility with all 
possible hardware/software configurations.

 

Use these only when required.

 

Mac OS 9

 

D

 

If you are using audio hardware for which there is a specific ASIO 
driver, you should select this.

 

With an ASIO driver written specifically for the audio hardware, Reason can 
communicate more or less directly with the audio hardware. The benefits are 
lower latency (see below), support for higher sampling frequencies (up to 96 
kHz in 24 bit/32 bit float resolution)

 

 

 

and possibly better support for addi-
tional hardware features such as multiple outputs.

 

D

 

If there is no specific ASIO driver for your audio hardware, you will 
use the Apple Sound Manager.

 

This is the sound driver protocol that comes with the Mac OS, and Reason 
communicates with the audio hardware using this.

 

D

 

If you plan to use the internal audio outputs on your computer, 
please select “SM Built-in”. 

 

D

 

If you have some additional audio hardware (such as USB-speak-
ers) installed, please select “SM Device Name”, where “Device 
Name” is the name of your audio hardware.

 

Windows

 

D

 

If you are using audio hardware for which there is a specific ASIO 
driver, you should select this.

 

With an ASIO driver written specifically for the audio hardware, Reason can 
communicate more or less directly with the audio hardware. The benefits are 
lower latency (see below) and possibly better support for additional hard-
ware features such as multiple outputs.

 

D

 

If there is no specific ASIO driver, you should select the Direct 
Sound driver for the audio hardware.

 

This makes Reason communicate with the hardware via Direct Sound (a part 
of the Microsoft DirectX package). For this to be possible, you need to have 
DirectX installed on your computer, and there must be a Direct Sound driver 
for the audio hardware.

 

The Direct Sound driver for a Creative SoundBlaster PCI card selected.

 

!

 

Please be aware that as of this writing, Windows XP ships with Di-
rectX version 8.1, and Windows 2000 with DirectX version 7.0. So if 
you’re using one of these operating systems it is not necessary to 
separately install DirectX, since it’s inherently a part of the operat-
ing system.

 

D

 

If the audio hardware doesn’t support Direct Sound (i.e. there is no 
Direct Sound driver available for the audio hardware), select the 
MME driver.
This makes use of Windows Multimedia Extensions, the part of Windows 
that handles audio, MIDI, etc. Using MME often results in larger latency val-
ues (see below).
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About Latency and other Audio Settings
In the audio page, you will find a number of additional settings for audio. The 
most important ones are Buffer Size and the corresponding readout for Output 
Latency. 

Latency is the delay between when audio is “sent” from the program and when 
you actually hear it. The latency in an audio system depends on the audio hard-
ware, its drivers and their settings. 

If the latency is large, you will notice that the sound is delayed when you play a 
device from a MIDI keyboard. You may also notice that reactions are delayed 
when adjusting controls on the device panels (for example, if you lower the vol-
ume of a device, you will not hear this immediately but after the latency time).

If you experience high latency values, you will need to make adjustments to your 
configuration. 

• If available, use the Buffer Size slider to lower the latency. 
• If this is greyed out, you may be able to lower the buffer size in the control 

panel for the audio hardware - click the Control Panel button to open this.

For more information, please consult the electronic documentation.

Setting up MIDI Input
Reason has a very wide-ranging MIDI support, allowing you to make use of up to 
seven different MIDI inputs on a multi-port MIDI interface or similar. This makes it 
possible to use several different MIDI controllers and play and tweak each de-
vice in the rack independently, or to play the devices in Reason from an external 
sequencer, etc. See the electronic documentation.

However, in this book we will stick with the standard way of playing Reason via 
MIDI: by connecting a MIDI controller to a single MIDI input and routing this to 
different devices in the rack via Reason’s sequencer. With this method you will 
be able to play and control one device at a time. Proceed as follows:

1. Open the Preferences dialog from the Edit menu (or Reason menu, 
if you are running Mac OS X).

2. Use the pop-up menu at the top of the Preferences dialog to select 
the MIDI page.

3. Pull down the Port pop-up menu in the Sequencer section and se-
lect the MIDI input to which your MIDI controller is connected.

4. Check on which MIDI channel your MIDI controller transmits, and 
set the Channel pop-up menu to this value.
The sequencer will only accept MIDI data on one channel at a time. This 
makes it possible to play via the sequencer and use MIDI Remote Control at 
the same time, even if you have a MIDI interface with a single input only (see 
the electronic documentation).

5. For now, also select the Advanced MIDI page from the pop-up menu 
and make sure the pop-up menus on this page are set to “No MIDI 
Input”.

Now, the Reason sequencer will receive MIDI data on the specified input port 
and MIDI channel. You may want to leave the Preferences dialog open for the 
following settings.
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Setting Sound and Patch 
Search Paths
Reason songs and patches can contain references to other files on your hard 
disk, such as samples. To keep track of all files, Reason makes use of a “data-
base”. If you keep your Reason files within the database, Reason can update file 
paths, automatically search for missing files, etc.

This database consists of up to four different folders on disk (and all their sub-
folders). You specify which folders to use as database in the following way:

1. In the Preferences dialog, use the pop-up menu at the top to select 
the Sound Locations page.

2. Click the “1” folder button below the heading “Sound and Patch 
Search Paths”.
A file dialog appears.

3. Navigate to the desired folder and select it.
You can select a folder on any drive (including mapped network drives under 
Windows).

4. Click OK.
The folder is added as the first search path in the database.

5. If you like, specify search path 2 to 4 in the same way.
It is normally enough to specify a single path, since all underlying folders are 
automatically included in the database. Use the additional paths if you use 
more than one hard drive, CD-ROM drives etc.

When you add sound files or save Reason files, you should place them within 
the database (under one of the specified search path folders).

Setting the default song
Every time you start Reason, and every time you select “New” from the File 
menu, a default song opens. The “standard” default song contains a few select 
devices. 

You can however decide exactly what you want the default song to look like, in 
the following way:

1. Open the Preferences dialog from the Edit menu (or Reason menu 
if you are running Mac OS X).

2. Use the pop-up menu at the top of the Preferences dialog to select 
the General page.

3. At the middle of this page, there is a section entitled “Default 
Song”.
You have three choices: “Empty Rack”, Built In” and “Custom”.

Select which one you want to use by clicking the corresponding radio but-
ton.
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• Empty Rack - This is an empty rack. Well, almost empty, since it contains the 
Reason hardware interface.

• Built In - This is a built-in Reason Song, containing a few devices. Note that 
it is not possible to open this song by regular means - via the browser - since 
it is not an “independent”.rns-file, and thus does not reside anywhere in the 
Reason folder. 

• Custom - This allows you to select a custom default song. Any Reason song 
can be used, so if you often create songs using the same or similar device 
setups, you can use a previously created song as the default song. This way, 
all new songs you create will have the same device setup.

D To select a custom default song, click the Folder icon to the right 
and browse to the desired Reason song.
The name of the selected song will then be displayed in the text box.



3 D Quick Tutorial
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About this Chapter
This chapter is a quick introduction to the basics in Reason, laid out as step-by-
step tutorials. At the end of the chapter you will also find a “guided tour”, de-
scribing the different areas and devices in the program.

! Before you proceed with the tutorials, you should have connected 
your equipment and made settings for audio and MIDI as described 
in the previous chapters.

Playing a Song
1. If you haven’t launched Reason yet, do so.

2. Pull down the File menu and select Open.
The Song Browser dialog appears. 

3. Navigate to the Reason program folder.

4. Open the Demo Songs folder and select the song “Tutorial 
Song.rns”.

5. Click Open.
The document window for the song is displayed on screen. This consists of 
a “virtual rack” with devices (this song contains four instrument devices and 
two effects), a sequencer section and a transport panel.

6. Click the play button on the transport panel (at the bottom of the 
window).
Playback starts. If everything is properly connected, you should now hear 
Reason play!

7. Click the stop button to stop playback when you’ve heard enough.

Now, try out some real-time mixing:

8. Click the stop button again.
This moves the song position to the start of the song, allowing you to play 
the song from the beginning again.

9. Near the top of the rack is a mixer device - make sure this is visible.
You may need to scroll the view using the vertical scrollbar to the right in the 
rack (or the scroll wheel on your mouse, if it is equipped with one).

If you look at the mixer, you will see that each mixer channel has a “tape strip” 
next to the volume fader. If a device is connected to a mixer channel, the tape 
strip is labeled with the device name. In this song, there are only four instrument 
devices, so only the four first mixer channels are labeled.

10. Click the play button to start playback.

11. While the song is playing, click and drag the faders to adjust the 
level of each instrument device.

12. Try changing the pan setting (stereo position) of a channel, by click-
ing the pan knob above the fader and dragging up or down.
Dragging up will turn the knob clockwise; dragging down will turn it counter-
clockwise.

The stop button. The play button.

The Mixer.

The scrollbar.
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You may also want to add some effects to the music. In this song, there are two 
effect devices connected: a delay and a chorus/flanger. These are connected as 
send effects from the mixer, allowing you to specify how much of each mixer 
channel signal should be sent to each effect.

13. Raise the Aux send level knobs at the top of a mixer channel.
Send 1 is connected to the delay, while send 2 goes to the chorus/flanger.

The Aux sends.

Finally, let’s try tweaking some controls on an actual instrument device, to 
change the sound. In this example we will use the Subtractor synthesizer device, 
but all devices have parameters that can be adjusted on the device panels in the 
same way.

Unless you have a very large screen, the Subtractor device isn’t visible right 
now. You could use the scrollbar to scroll the rack down, but here’s a quicker 
way:

14. In the sequencer area (above the transport panel), click on the 
name “Subtractor” in the track list to the left.
The rack is automatically scrolled to bring the Subtractor device into view.

15. Try adjusting some parameters while the song is playing.
You may for example want to tweak the “Filter 1 Freq” slider, to change the 
brightness of the synth bass sound.

That concludes the first tutorial! Now, let’s move on to creating a Reason song 
from scratch.

Creating a new song
In this tutorial we will start with an empty rack, to let you add your own devices 
“from scratch”.

1. If you like, close the current song by selecting Close from the File 
menu.
You can have several song documents open in Reason at the same time, but 
each song uses some memory and computing power, so it’s good practice 
to close songs you don’t need.

2. Pull down the File menu and select Open.

3. Navigate to the Reason program folder and open the Template 
Songs folder.

4. Select the file “Empty Rack.rns” and click Open.
A song document window appears. This consists of an (almost) empty rack 
and there are no tracks in the sequencer.

! Normally when you create a new song, you would select “New” 
from the File menu. This command opens the default song (see 
page 93). The built-in default song contains a few devices, but if you 
have set things up so that the default song is “Empty Rack.rns”, you 
can just select “New” from the File menu, and ignore step 1 - 4 
above. See page 93 for instructions on setting up the default song.

5. Pull down the Create menu and select Mixer 14:2.
A mixer device is created in the rack. 

! The reason why you should start with a mixer device, is that all sub-
sequent devices you add will then automatically be connected to a 
mixer channel.

6. Pull down the Create menu and select Subtractor Analog Synth, 
and then Redrum Drum Computer.
You have now added two instrument devices to the rack. If you look in the 
sequencer, you will note that two tracks have automatically been added, one 
for the synthesizer and one for the drum machine.
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Now you could try playing the Subtractor synth “live” (provided you have a MIDI 
keyboard or similar hooked up):

7. In the sequencer, click in the In column for the synthesizer track (to 
the left of the name), so that a MIDI connector symbol is shown.
This symbol indicates that incoming MIDI is routed to the track. And since 
the track is connected to the Subtractor device, any notes you play on your 
MIDI keyboard will be sent to the synth.

MIDI routed to the Subtractor track.

8. Try playing your MIDI keyboard.
What you hear now is the default “Init” sound of the Subtractor, which may 
not be so inspiring. You could start tweaking the parameters to create a 
sound of your own, or you could select one of the included synth patches 
(and tweak this to your liking):

9. Click the folder button on the Subtractor panel.
This opens the Patch Browser dialog.

10. Click the Find All ReFills button at the top of the dialog.

A ReFill is a kind of component package for Reason which can contain patches, 
sounds, demo songs, etc. Clicking the Find All ReFills button tells the browser 
to display all available ReFills.

11. In the browser file display, double click on “Reason Factory Sound 
Bank”.
This is one huge ReFill containing a large number of patches and samples 
that are included with Reason when you purchase it.

12. Double click the folder “Subtractor Patches”.
This contains a number of folders with different sound categories.

13. Open one of the folders, select a patch and click Open.
The settings in the patch are applied and the patch name is shown in the dis-
play.

D Once you have selected a patch this way, you can step between the 
patches in the same folder, by clicking the up and down arrow but-
tons next to the patch display.
Alternatively, you can right-click in the patch name display to bring up a con-
text menu with all the patches in the folder.
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It’s possible to play the drum machine device via MIDI in the same way, but let’s 
try creating a pattern with the built-in pattern sequencer instead:

14. Click the folder button in the lower left corner of the Redrum panel.
This opens the patch browser for the drum machine, allowing you to select a 
Redrum patch (a drum kit). Note that there are folder buttons for each drum 
sound channel too - these let you add drum samples one by one and create 
your own drum kits.

15. Select a Redrum patch in the same way as you selected a Subtrac-
tor patch.
The patches are located in category folders within the folder “Redrum Drum 
Kits” in the Reason Factory Sound Bank.

When you have selected a patch, you will note that a sample file name is dis-
played at the top of each drum sound channel in the drum machine. There may 
also be different parameter settings for the different drum sounds - all these set-
tings are part of a Redrum patch.

16. Try out the drum sounds by clicking the audition buttons at the top 
of each drum sound channel.

Now, let’s start building a pattern. By default, the empty patterns have sixteen 
steps, with each step corresponding to a sixteenth note (so that the length of a 
pattern is one 4/4 bar). To make things simple, we’ll keep this setting for now.

17. Click the Run button on the Redrum device panel.
The pattern will start playing (as indicated by the running “LED” on the step 
buttons at the bottom of the device panel). Nothing will be heard, since you 
haven’t added any drum beats yet.

The Select Patch button

Load Sample buttons

The selected patch

Drum sound channels
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18. Click the Select button for one of the drum sounds.
In Redrum, you add drum beats for one sound at the time.

19. Click on the first step button (marked 1).
The button lights up, indicating a drum beat. 

You will now hear the sound of the selected drum on the first beat of each bar.

20. Add more drum beats by clicking other step buttons.
Clicking a lit step button will remove the beat.

✪ You can add beats of different strength (velocity level) by adjusting 
the Dynamic switch. Exactly how each sound is affected by different 
velocity levels depends on the settings. 
You can also adjust the dynamics “on the fly” by pressing [Shift] or 
[Option] (Mac) / [Alt] (Windows) when you add beats. [Shift]-click 
for hard beats, [Option]/[Alt]-click for soft beats.

21. Select another drum sound (by clicking its Select button) and pro-
ceed in the same way until you have a drum pattern you want to 
use.

22. To stop the playback, click the Run button again.

Now try recording some synth notes in the sequencer:

23. Click in the In column for the synthesizer track in the sequencer so 
that the MIDI connector symbol appears.

24. Click the record button in the transport panel.
The button lights up, indicating record standby mode.

25. Click the play button.
Recording is activated, and the drum machine pattern automatically starts 
playing.

26. Play your MIDI keyboard while listening to the drum pattern.

27. When you’re done, click the stop button.

28. Click stop again to move the song position to the beginning of the 
song.
You can also click and hold the rewind button.

29. Click play to listen to your recording.

Finally, let’s record some automation of a synthesizer parameter. In this example, 
we automate the cutoff frequency of the filter (Filter 1 Freq), but you can auto-
mate any parameter you like.

30. Rewind the song to the beginning again.

31. Make sure the Overdub/Replace switch (just below the record but-
ton) is in the Overdub position.
This allows you to record more on the same track, without removing the pre-
vious recording.

32. Click the record button and then the play button.
Recording starts. You will hear the recorded synth notes being played back.

The Stop button

The Play button The Fast Forward button

The Rewind button The Record button

The Overdub/Replace switch
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33. Click and drag the Filter 1 Freq slider on the Subtractor panel.
The changes you make will be heard immediately.

34. Click stop twice to end recording and go back to the beginning of 
the song.
If you look at the Subtractor panel, you will note that there is a green frame 
around the filter slider now. This indicates that the parameter is automated.

35. Play back the song again.
You will see the filter slider moving, exactly as you moved it during recording.

This concludes the second tutorial!
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Guided Tour
On the following pages you will find a brief “guided tour” through the program. 
This helps you get familiar with the different devices and their uses.

The Rack

This is the virtual rack, the heart of Reason. At the top of the rack you will always 
find the Hardware Interface, which allows Reason to communicate with the au-
dio hardware and MIDI interfaces. Below this, you can add as many different de-
vices you want (or as many as your computer can handle). Read more about the 
different devices below.

The Back
If you press [Tab] or select Toggle Rack Front/Rear on the Options menu, the 
rack will be “turned” to show you the back.

Here, the back panel of each device in the rack is shown. As you can see, con-
nections between devices are indicated by “virtual patch cables”. Connections 
between instrument devices and mixers use red cables, connections to or from 
effect devices use green cables and CV connections (Control Voltage, used for 
controlling parameters or triggering sounds) use yellow cables. You can make 
connections by clicking and dragging from one “socket” to another on the back 
panels.

To turn the rack over again (to show the front panels), use the same command.
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The Transport Panel

The panel at the bottom of each song document window is called the transport 
panel. It contains transport controls and settings that are global for the song, 
such as tempo and time signature, shuffle amount, CPU load indicator, etc.

The Sequencer
The sequencer is located in the area below the rack. This is where you record 
and edit notes, controllers, device parameter automation and pattern changes.

The left part of the sequencer area is the track list, showing the names of the se-
quencer tracks. The columns in the track list allow you to connect tracks to de-
vices, route MIDI and mute or solo tracks.

The track list.

The right part of the sequencer area has two main modes, the arrange view and 
the edit view.

When the arrange view is selected, you will see the tracks lined up vertically, 
with the recorded events indicated as colored bars (red for notes, yellow for pat-
tern changes and blue for controllers). A ruler at the top of the view shows the 
meter positions.

The sequencer with the arrange view selected.

When the edit view is selected, the right part of the sequencer area will contain 
one or several lanes, showing the recorded data in detail. There are specific 
lanes for editing notes, pattern changes, controller data, etc.

The edit view, with the drum lane, velocity lane, pattern lane and two controller lanes visible.
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The Devices
The following devices are available in Reason:

Reason Hardware Interface

This device handles Reason’s communication with your hardware.

The upper half of the hardware interface contains settings for MIDI input, allow-
ing you to select a separate MIDI channel for each device when controlling Rea-
son from an external multi-channel MIDI source.

! For standard MIDI control of one device at a time in Reason, you 
don’t need to use the hardware interface (since the MIDI signals are 
routed through the sequencer, as described in the tutorials earlier 
in this chapter).

The lower half of the hardware interface contains audio output indicators with 
level meters. This is where you connect different devices to different outputs on 
your audio hardware. Reason supports up to 64 separate audio outputs. How-
ever, if you are only using audio hardware with standard stereo outputs, the con-
nections to the audio hardware are automatically taken care of when you create 
a mixer device at the top of the rack.

! The Reason Hardware Interface is “riveted” into the rack, and can-
not be removed.

Mixer

This is a mixer with fourteen stereo channels, four stereo effect sends and a ba-
sic two-band EQ section. By connecting the different devices to different mixer 
channels (and the stereo output of the mixer to the hardware interface) you can 
listen to all your devices at the same time, adjust levels and pan, add effects and 
so on - just like on a physical mixer.

Subtractor Analog Synth

The Subtractor is a polyphonic synthesizer laid out much like an advanced ana-
log synth. It features two oscillators, two filters and a host of modulation func-
tions, allowing for everything from fat basses to swirling pads and screaming 
lead sounds.
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Malström Synth

The Malström is a polyphonic synthesizer featuring two oscillators, two modula-
tors, two filters, a waveshaper and a large number of modulation and routing op-
tions. It is based on the concept of Graintable Synthesis and makes it possible 
to produce amazingly abstract, sharp, distorted, undulating sounds. 

NN-19 Digital Sampler

The NN-19 allows you to load samples (Wave, AIFF, SoundFonts or REX files) 
and create multi-sample patches by mapping samples across the keyboard. 
Once you have loaded one or several samples, you can modify the sound using 
synth-type parameters such as a filter, envelopes and an LFO.

NN-XT Digital Sampler

The NN-XT - just like the above mentioned NN-19 - lets you load samples 
(Wave, AIFF, SoundFonts or REX files) and map these across the keyboard to 
create multi-sample patches. The sound can then be modified using synth-type 
parameters; two LFOs, two envelopes and a filter. 

In addition, the NN-XT also allows you to create layered sounds, where two or 
more samples can be played simultaneously. This is done by mapping different 
samples across the same keyboard range. Another useful feature is the possibil-
ity to set up velocity switched key maps. This lets you control which samples in 
a layered key map will actually sound depending on how hard or soft you play on 
your MIDI keyboard.
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Dr. Rex Loop Player

The Dr.Rex Loop Player plays REX files - audio files created in ReCycle, another 
Propellerhead Software product. ReCycle is a program designed especially for 
working with sampled loops. By “slicing” a loop and making separate samples of 
each beat, ReCycle makes it possible to change the tempo of loops without af-
fecting the pitch and to edit the loop as if it were built up of individual sounds.

After loading a REX file into the Dr. Rex Loop Player, you can play it back in vir-
tually any tempo, make settings for individual slices, extract MIDI playback data 
and process the loop with the built-in filter, LFO and envelopes. You can also 
play the individual slices via MIDI or from the sequencer - each slice has a spe-
cific note number (C1 for the first slice, C#1 for the next and so on). A number 
of REX files are included in the Reason Factory Sound Bank.

Redrum Drum Computer

The Redrum is a sample-based drum machine with ten drum sound channels. 
You can load samples (Wave, AIFF, SoundFont files and REX slices) individually 
for each channel, or open patches, which are complete drum kits (a number of 
which are included in the Reason Factory Sound Bank). Each sound channel 
has settings for pitch, level, velocity response, etc.

There is a built-in pattern sequencer, allowing you to create classic drum ma-
chine patterns, complete with shuffle and flam options. It is also possible to use 
Redrum as a sound module, playing it live from an external MIDI controller or 
from the main Reason sequencer. You may for example have the pattern se-
quencer play a basic drum pattern, and add fills and extras in the main se-
quencer. As with the Dr.Rex loop player, each drum sound has a specific note 
number (C1 for drum sound 1, C#1 for drum sound 2 and so on).
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BV512 Vocoder

The BV512 is an advanced vocoder device with a variable number of filter bands 
and a unique 1024-point FFT vocoding mode (equivalent of 512-band vocod-
ing) for very precise and high quality vocoded speech. By connecting the 
BV512 to two instrument devices, you can produce anything from vocoded 
speech, singing or drums to weird special effects.

Scream 4 Sound Destruction Unit

This is an extremely versatile sound destruction device, featuring various kinds of 
distortion, signal warping and transformation effects. There are three main sec-
tions: “Damage” (where you select a sound mangling algorithm and make set-
tings), “Cut” (a three band EQ) and “Body” (a resonant body or cabinet 
simulator, excellent for making the sound come alive).

RV7000 Advanced Reverb

The RV7000 is a high quality reverb processor with nine different reverb and 
echo algorithms, ranging from rooms and halls to special effects. The RV7000 
also contains an equalizer and a gate section, making it possible to get virtually 
any kind of reverb character, including gated reverb.

RV-7 Digital Reverb

This is a reverb effect with ten different reverb algorithms, ranging from hall and 
room simulations to special effects. You can fine-tune the effect with the knobs 
on the device panel if you like. The reverb is normally used as a send effect.

DDL Digital Delay Line

This is a basic digital delay, useful for echoes, slapback, doubling, etc. The delay 
time can be set in steps based on and synchronized to the current song tempo, 
or in milliseconds for free-running delays. The maximum delay time is 2.0 sec-
onds.

D-11 Foldback Distortion

The D-11 is a simple but highly effective distortion device, that can convert mel-
low synth sounds to screaming leads and basses, add grit and dirt to drum pat-
terns or loops, etc.

ECF-42 Envelope Controlled Filter

This is a synth-style resonant filter with three different filter modes. You can ei-
ther use it as a “static” filter (and vary the filter frequency on the device panel, or 
via Control Voltage from another device) or use the built-in envelope to create 
rhythmic filter effects of various kinds. The envelope can for example be trig-
gered by a drum machine or the Matrix pattern sequencer.
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CF-101 Chorus/Flanger

The CF-101 does double duty as chorus (for making textures rich and swirly) 
and flanger (for creating sweeping, metallic effects). You can use it as a send ef-
fect or as an insert effect (connected between an instrument device and a 
mixer).

PH-90 Phaser

The PH-90 is a stereo phaser effect. It has six parameters available on the de-
vice panel, allowing you to create both subtle sweeping sounds and extreme, 
swirling special effects.

UN-16 Unison

The UN-16 simulates the sound of several detuned voices playing the same 
notes simultaneously, producing a rich chorus-like effect with the voices spread 
across the stereo field if you like.

COMP-01 Compressor

This is a combined compressor and limiter. It will affect the dynamics of the 
sound, by boosting low levels and attenuating loud sounds. Use it for keeping 
levels even (from individual devices or the whole mix), for adding punch and 
power to drums, etc.

PEQ2 Two Band Parametric EQ

While the mixer device has basic two-band EQ on each channel, sometimes you 
may need some more precise control over the tone color. For this purpose, you 
can use the PEQ2. This device contains two independent parametric equalizers, 
with controls for frequency, gain and Q value. 

Spider Audio Merger & Splitter

This is not an effect device, but a utility. With the Spider Audio you can merge 
up to four audio input signals into one output, as well as split one audio input 
signal into four outputs. This makes audio signal routing much more flexible and 
allows for very creative patching and connections.

Spider CV Merger & Splitter

Again, this is not an effect device, but a utility. With the Spider CV you can 
merge up to four CV input signals into one CV output, as well as split CV or 
Gate inputs into several outputs (one of which can be inverted). One use for the 
Spider CV is to split Gate and Note CV to control several instrument devices 
with one Matrix.

The Matrix Pattern Sequencer
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The Matrix is a stand-alone pattern sequencer, somewhat similar to a vintage an-
alog sequencer. A Matrix pattern can have between 1 and 32 steps, and for 
each step you can specify which control voltage levels should be sent out from 
the three separate CV outputs on the back of the device. If you like, you could 
view this as having three separate pattern sequencers in one.

By connecting the Matrix to e.g. a synth device, you can have the pattern se-
quencer play the device (for a repeating synth pattern), or control various param-
eters, for rhythmic effects that you cannot obtain using the synth device alone.

ReBirth Input Machine

This device allows you to use Reason in conjunction with Propellerheads’ clas-
sic ReBirth application. The audio from ReBirth will be “streamed” via the Re-
Wire protocol into Reason. By routing the different outputs on the ReBirth Input 
Machine to different mixer channels, you can mix the sound of ReBirth with the 
sound of Reason, add effects to separate ReBirth sounds, etc.



QUICK TUTORIAL34



4 D Common Operations and Concepts
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About this Chapter
This chapter describes some general methods and techniques employed 
throughout Reason. It also contains some terminology, useful for better under-
standing of the program and the manual. To make your work with Reason as ef-
fective and rewarding as possible, we recommend that you read this chapter.

Conventions in the 
Manual
This manual describes both the Macintosh version and the Windows version of 
Reason. Wherever the versions differ, this is clearly stated in the text.

About Key Commands
In the manual, computer key commands are indicated by brackets. For example, 
“press [Shift]-[C]” would mean “hold down the [Shift] key and press the [C] 
key”. However, some modifier keys are different on Mac and PC computers, re-
spectively. Whenever this is the case, the manual separates the commands with 
“(Mac)” and “(Windows)” indications.

Making Settings
Since a large part of Reason is laid out like a “real” effect and synth rack, almost 
all parameters are designed like their real world counterparts - mixer faders, 
synth knobs, transport buttons, etc. How to make adjustments to these is de-
scribed separately for each type of parameter below:

Knobs

To “turn” a knob, point at it, click the mouse button and drag up or down (as if 
the knob was a vertical slider). Dragging upwards turns the knob to the right and 
vice versa.

D If you press [Shift] and drag, the knob will turn slower, allowing for 
higher precision.
You can also adjust the knob precision with the “Mouse Knob Range” set-
ting on the General page in the Preferences dialog. This dialog is opened 
from the Edit menu (or from the Reason menu if you are running Mac OS X).

D To reset a knob to its default value (usually zero, center pan or sim-
ilar), press [Command] (Mac) or [Ctrl] (Win) and click on it.
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Sliders

To move a slider, click on the slider handle and drag up or down.

D You can also click anywhere on the slider to instantly move the han-
dle to that position.

D If you press [Shift] and drag, the slider will move slower, allowing 
for higher precision.

Multi Mode Selectors
Some parameters allow you to select one of several modes. There are two differ-
ent graphical representations of this in Reason:

This type of multi mode selector consists of a button with the different modes listed above. 
You can either click the button to step through the modes or click directly on one of the 
modes to select it. The currently selected mode is indicated by a lit LED.

This type of multi mode selector is a switch with more than two settings. To change mode, 
click and drag the switch, or click directly at the desired switch position (just as when 
adjusting a slider).

Buttons

Many modes and functions are controlled by clicking buttons. Most of the but-
tons in Reason have a “built-in” LED, indicating whether the button is pressed or 
not.

Numerical Values
In Reason, numerical values are displayed in alphanumeric readouts with “spin 
controls” (up/down arrow buttons) on the side. There are two ways to change 
numerical values:

D By using the up and down buttons on the spin controls.
To adjust a value in single steps, click on its up or down arrow button. To 
scroll a value continuously, click on an arrow button and keep the mouse 
button pressed.

D By clicking in the actual alphanumeric display and dragging up or 
down with the mouse button pressed.
This allows you to make coarse adjustments very quickly.

✪ This type of control is also used for some parameters that are not 
purely “numerical” (e.g. reverb algorithms and synth oscillator 
waveforms).

The position values on the transport panel can also be edited by double clicking 
and typing a new position.



COMMON OPERATIONS AND CONCEPTS38

Tool Tips
If you position the pointer over a parameter on a device panel and wait a mo-
ment, a tool tip will appear. This displays the name of the parameter and its cur-
rent value. This helps you fine-tune settings, set several parameters to the same 
value, etc.

✪ You can turn off these tool tips by deactivating the option Show Pa-
rameter Value Tool Tip on the Preferences-General page.

Context menus
Context menus are “tailored” to contain the relevant menu items only, allowing 
you to work quicker and more efficiently with Reason.

D To bring up a context menu, click with the right mouse button (Win-
dows) or press [Ctrl] and click (Mac).
If you are using a Macintosh with a two button mouse, you may want to set 
this up so that clicking the right mouse button generates a [Ctrl]-click. This 
way, you can right-click to bring up context menus.

The Dr. REX context menu.

The contents of the context menu depends on where you click. Basically, the fol-
lowing different context menu types are available:

Device Context Menus
If you click somewhere on a device in the rack (but not on a control), the context 
menu will contain the following items:

• Cut, Copy, Paste and Delete Device items, allowing you to rearrange and 
manage the devices in the rack.

• A Go To submenu, listing all devices connected to the current device. Se-
lecting a device from the Go To submenu scrolls the rack to bring that de-
vice into view.

• A duplicate of the Create menu, allowing you to create new devices.
• If the device is pattern-based, there will be various pattern functions (Cut/

Copy/Paste, Clear, Shift, Randomize, etc). These affect the currently se-
lected pattern in the device.

• If the device uses Patches, there will be functions for managing Patches.
• Depending on the device there may also be various device-specific func-

tions available. For example, the drum machine device has functions for ma-
nipulating the pattern for the selected drum sound only, etc.

Parameter Context Menus
If you click on an automatable control (a synth parameter knob, a fader, etc), the 
context menu will contain the following items:

• Functions for clearing and editing the recorded automation data for the con-
trol.

• Functions for associating computer keyboard commands and/or MIDI mes-
sages to the parameter (allowing you to remote control parameters from a 
MIDI device or the computer keyboard).

“Empty Rack” Context Menus
If you click in an empty section of the rack, the context menu will contain the fol-
lowing items:

• A Paste Device item, allowing you to paste any copied or cut devices into 
the rack.

• A duplicate of the Create menu, allowing you to create new devices.

Sequencer Context Menus
If you click in the sequencer, the context menu will contain items related to edit-
ing Tracks, Groups and Events. The available items will differ depending on in 
which area or lane you click (Track list, Key Edit lane, etc.), and depending on 
whether you click on an event or not. For example, the sequencer context menus 
contain functions for inserting or removing bars, adding tracks, and grouping, 
changing or deleting events. See the electronic documentation for details.
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Undo
Virtually all actions in Reason can be undone. This includes creation, deletion 
and reordering of devices in the Rack, parameter value adjustments, editing in 
the sequencer and tempo/time signature adjustments. You can undo up to 10 
actions.

D To undo the latest action, select “Undo” from the Edit menu or 
press [Command]/[Ctrl]-[Z].
The action to be undone is indicated next to the Undo command on the Edit 
menu. For example, if your latest action was to delete some device(s) from 
the Rack, the Edit menu will say “Undo Delete Devices”.

D To redo the last undone action (“undo the undo operation”), select 
“Redo” from the Edit menu or press [Command]/[Ctrl]-[Y].
Similarly, the action to be redone is shown on the Edit menu.

About Multiple Undos
The concept of multiple undos may require an explanation: You can undo up to 
10 actions, or in other words, Reason has an Undo History with up to ten steps.

Let’s say you have performed the following actions:

1. Created a mixer.

2. Created a synth device. 

3. Adjusted the Amp Envelope Attack time on the synth.

4. Changed the panning for the synth device in the mixer.

5. Adjusted the playback tempo in the transport panel.

After these five actions, the Undo History will look as follows:

If you now select Undo, your latest action (the tempo change) will be undone, 
and moved to a “Redo list”:

Selecting Undo again undoes the next action in the list (the panning adjust-
ment):

If you now select Redo, the last undone action will be redone. In this case, your 
panning adjustment will be performed again (and added to the Undo History 
again):

At this point, you still have the option to Redo the tempo change. But if you in-
stead would perform another action (e.g. change the level of the synth device in 
the mixer), this would become the action at the top of the Undo History - and the 
Redo list would be cleared.

Now you can no longer redo the undone tempo change!

5. Adjust tempo

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device

UNDO

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device

UNDO

5. Adjust tempo

REDO

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device

UNDO

5. Adjust tempo

REDO

UNDO

5. Adjust tempo

REDO

4. Change pan

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device

4. Change pan

3. Adjust Attack

2. Create Synth Device

1. Create Mixer Device

UNDO REDO

(empty)

5. Change level
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Window Techniques
Using more than one Reason Song window
You can have several Reason Songs open at the same time. Each will appear in 
a separate Reason window, complete with rack, sequencer and transport bar ar-
eas. Each window can be moved, minimized and resized using standard Mac/
Windows procedures. 

On the Windows menu, you will find some items for arranging the open win-
dows. These are described in the electronic documentation.

Views, Panes and Dividers
On screen, Reason is divided into different areas or “panes”. The most obvious 
example is the rack and the sequencer area, but you will also find that the right 
part of the sequencer area can be divided into several horizontal lanes (for edit-
ing different aspects of your recordings).

The borders between the lanes are called dividers. You can adjust the height of 
the lanes by clicking on their divider and dragging up or down. Enlarging the up-
per lane will shrink the lower and vice versa.

Detaching the sequencer
You can detach the sequencer pane and turn it into a separate window. This al-
lows you to make the sequencer wider than the rack and use the width of the 
computer screen more effectively. See page 60.
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Scrolling and Zooming
Reason offers a few different options for scrolling and zooming in the rack and 
the sequencer.

Scrolling with the scrollbars

Whenever there is information “outside the screen”, horizontal and/or vertical 
scrollbars will appear. For example, if there are more devices in the rack than can 
be shown at one time, you will be able to scroll the rack up or down by using the 
vertical scrollbar to the right of the rack.

Scrolling with the Hand tool

In the sequencer, you can also use the Hand tool for scrolling the view. Just se-
lect the Hand tool and click in a lane, keep the mouse button pressed and drag 
in the desired direction.

Scrolling the Key edit lane with the Hand tool.

✪ You can scroll in any direction as long as the lane allows it (the Ve-
locity lane for example is only possible to scroll horizontally). By 
holding down [Shift] while you drag however, you can limit the 
scrolling direction to horizontal or vertical only.

Zooming with the magnification sliders

Some areas also allow you to zoom in or out using magnification controls. Either 
click the “+” or “–” magnification icon to zoom in or out respectively, or click and 
drag the magnification slider.

D Where applicable, different panes can be scrolled and zoomed indi-
vidually.

In the sequencer, there are separate view controls for the Key edit lane and the 
Controller lane.

Zooming with the Magnifying Glass tool

Another way of zooming in the sequencer is to use the Magnifying Glass tool. 
This tool lets you zoom in and out both horizontally and vertically just like the 
magnification sliders do. However, the Magnifying Glass tool offers a few more 
possibilities. 

The following applies:

D By clicking once in a lane with the Magnifying Glass, you zoom in by 
the same amount as when clicking the “+” icon on the magnifica-
tion slider twice.

D To zoom out with the Magnifying Glass, click while keeping [Op-
tion] (Mac)/[Ctrl] (Windows) pressed.
You’ll notice that the “+” sign in the Magnifying Glass tool changes to a “-” 
sign.

D If the lane has a vertical magnification slider as well, clicking with 
the Magnifying Glass will also zoom in/out vertically by the same 
amount as when clicking the“+” and ”-” icons on the magnification 
slider once.
By holding down [Shift] when clicking, you disable vertical zooming.
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D You can also click and drag with the Magnifying Glass to create a 
selection rectangle.
The view will then be zoomed in so that the selected area fills the lane.

Scrolling and zooming with the mouse wheel

If you’re using a mouse equipped with a scroll wheel, this can be used for the fol-
lowing scrolling and zooming operations:

D Scrolling up and down in both the rack and in the sequencer.

D By simultaneously holding down [Shift] you can scroll left and right 
in the sequencer.

D By holding down [Command] (Mac)/[Ctrl] (Windows), you can zoom 
in and out vertically in the sequencer.

D By holding down [Shift]-[Command] (Mac)/[Shift]-[Ctrl] (Windows), 
you can zoom in and out horizontally in the sequencer.

Enclosing these notes in a selection rectangle...

...will zoom in so that they fill the view.



5 D Audio Basics
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About this chapter
This chapter contains some useful information about how audio is handled by 
Reason. Some of it may seem a bit technical, but we recommend that you read 
it, to get the most out of Reason.

How Reason 
communicates with your 
audio hardware
Reason generates and plays back digital audio - a stream of numerical values in 
the form of ones and zeroes. For you to be able to hear anything, this must be 
converted to analog audio and sent to some kind of listening equipment (a set of 
speakers, headphones, etc.). This conversion is most often handled by the audio 
card installed in your computer (on the Macintosh you can use the built-in audio 
hardware if you don’t have additional audio hardware installed).

To deliver the digital audio to the audio hardware, Reason uses the driver you 
have selected in the Preferences dialog (see page 14). In the rack on screen, 
this connection is represented by the Reason Hardware Interface.

The Hardware Interface is always located at the top of the rack.

! If you are using ReWire, Reason will instead feed the digital audio 
to the ReWire master application (typically an audio sequencer pro-
gram), which in turn handles the communication with the audio 
hardware. This is described in the electronic documentation.

The Reason Hardware Interface contains 64 output “sockets”, each with an indi-
cator and a level meter. Each one of these indicators represents a connection to 
an output on your audio hardware (or a ReWire channel to another application if 
you are using ReWire - see the electronic documentation).

However, the number of outputs available depends on the number of outputs on 
your audio hardware. For example, if you are using a standard sound card with 
stereo outputs (or the built-in audio hardware on the Mac), only the first two out-
puts will be available. In the Hardware Interface device, the green indicators are 
lit for all currently available outputs. 

In this case, a standard stereo audio card is used, and only the first two outputs (marked 
“Stereo” on the device panel) are available. 

Here, an audio card with eight outputs is used.

To send the sound of a device in the rack to a specific output, you route the de-
vice output to the corresponding “socket” on the Hardware Interface. This is 
done by using the “virtual patch cables” on the back of the rack, as described on 
page 51. In most cases, you will want to connect a mixer device to the Stereo 
outputs (outputs 1 and 2).
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About Sample Rates and 
Resolutions
Sample rate and resolution are properties of digital audio, which determine the 
quality of the sound. Generally, higher sample rate and resolution result in better 
audio quality (but also larger audio files and higher demands on computer per-
formance and audio hardware). This table shows some common sample rate/
resolution combinations:

To cater for all different situations, Reason supports multiple sample rates and 
resolutions. This applies to the following areas:

Playing back

Reason handles all internal audio processing in 32-bit floating point resolution. 
However, the resolution of the output audio is determined by the audio hard-
ware. That is, if you have a 24-bit audio card, Reason will create audio in 24-bit 
resolution, and if you have a 16-bit audio card, audio will be in 16-bit resolution.

The playback sample rate can be specified in the Preferences-Audio dialog (ac-
cessed from the Reason menu or Edit menu depending on whether you are run-
ning Mac OS X or not):

Note that the available options on this pop-up menu depend on which sample 
rates are supported by the audio hardware. Most standard sound cards support 
44.1 kHz and various lower sample rates, in which case you should select 44.1 
kHz for best audio quality.

About using high resolution audio

Reason has the capability to play back samples with practically any resolution. 
This means that if for instance 24-bit samples are loaded in a sampler or the Re-
drum, playback of the samples can be in 24-bit resolution as well. If you are us-
ing such samples and want Reason to play them back in their original high 
resolution, proceed as follows:

1. Open the Preferences from the Edit menu or Reason menu, and se-
lect the General page.

2. Under “Miscellaneous” at the bottom of the page, make sure the 
option “Use High Resolution Samples” is checked.

If this is activated, and if your audio card supports it, Reason will play back high 
resolution samples in their original resolution. If this option is not activated, Rea-
son will play back all samples in 16-bit resolution, regardless of their original res-
olution.

Exporting audio

Reason can export audio, i.e. mix down the song or a section of the song as an 
audio file (see page 94 for details). When you do this, you will be asked to spec-
ify a resolution (16 or 24 bit) and sample rate (11–96 kHz) for the file.

✪ If you plan to open the exported file in another application, you 
should select a format that is supported by the application. If you’re 
uncertain, 16 bit/44.1 kHz is a safe bet.

Importing audio

When loading samples or ReCycle files into the samplers, the drum machine de-
vice or the loop player, Reason supports files of a large number of sample rates 
and resolutions. You can use files of different formats in the same device - one 
drum sound can be an 8-bit sample, the next a 16-bit sample, etc.

| Sample rate: | Resolution: | Comment:

22.05 kHz 8 bit Typically used in situations where small file 
size is more important than audio quality, such 
as games, some multimedia applications, 
sound files on the Internet, etc.

44.1 kHz 16 bit This is the format used on audio CDs (often 
called “CD Quality audio”).

44.1 kHz – 
96 kHz

24 bit These are formats used in professional studios 
and high-end recording equipment.
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About Audio Levels
When playing back in Reason, you should keep an eye on the Audio Out Clip-
ping indicator on the transport panel. If this lights up, the audio level is too high, 
resulting in clipping (digital distortion).

D To remedy this, lower the master level on the mixer (or other device) 
that is connected to the Hardware Interface, until Audio Out Clip-
ping doesn’t light up on playback.

! Note that it doesn’t matter if the level meters on the individual de-
vices (effects, mixer channels, etc) “hit the red”. Clipping can only 
occur in the Hardware Interface. 

The technical reason for this is that internally, Reason uses high resolution float-
ing point processing, which ensures high audio quality and virtually limitless 
headroom. In the Audio Hardware device, the floating point audio is converted to 
the resolution used by the audio hardware, and that’s where clipping may occur.

If you are using multiple outputs
If you are using audio hardware with more than two outputs, you may have differ-
ent devices connected to different outputs in the Hardware Interface. If the Au-
dio Out Clipping indicator lights up, you should play back the section again 
while checking the Hardware Interface. Each output socket has a level meter - if 
the red meter segment lights up, the output is clipping. Lower the output level of 
the device connected to the clipping output, until no clipping occurs.

Clipping on the stereo outputs.

If you are using ReWire
If you are streaming audio to another application using the ReWire protocol, 
clipping can not happen in Reason. This is because the conversion from floating 
point audio happens in the other audio application. See the electronic documen-
tation for more information about ReWire.

Master Tune
By default, Reason plays back a “middle A” at 440 Hz, which is the standard 
tuning in most instruments. However, if you are playing Reason together with 
other instruments, you may want to adjust the tuning:

1. Pull down the Edit menu (or Reason menu, under Mac OS X) and 
select Preferences...

2. Use the pop-up menu at the top of the Preferences dialog to select 
the Audio page.

3. Adjust the global tuning with the Master Tune control.
If you like, you can adjust this during playback. Note that this affects the tun-
ing of all sound sources in Reason, including the drum machine and loop 
player.

The indicator will stay lit for a short 
moment, to make it easier to spot.



6 D Managing the Rack
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About this Chapter
As you have seen by now, the central part of Reason is the rack. This is where 
you create and configure your devices, and make parameter settings. This chap-
ter describes all the procedures for managing the rack, that is, procedures and 
techniques common to all devices. Device parameter specifics are described in 
the electronic documentation.

Navigating in the Rack
If the rack contains more than a few devices, the whole rack will probably not 
“fit” on screen. To scroll the rack up or down, use one of the following methods:

D Use the scrollbar to the right of the rack to scroll continuously up or 
down.

D If you’re using a mouse equipped with a scroll wheel, you can use it 
to scroll up or down.

D Use the Page Up/Page Down buttons on the computer keyboard to 
move the view one “full screen” up or down.

D Use the Home or End buttons on the computer keyboard to scroll 
the top or bottom of the rack.

D Pull down a device context menu and select another device from 
the Go To submenu.
The rack scrolls to the device you select.

✪ When you select a device or its sequencer track (see page 61), Rea-
son will automatically scroll the rack to make the device visible. 

Note that you can enlarge the rack area by clicking its lower edge (the divider 
between the rack and the sequencer area) and dragging downwards. This will 
shrink the sequencer area and make more of the rack visible (alternatively, you 
can detach the sequencer from the rack altogether. This is described on page 
60). You can also make the rack fill the window by clicking the maximize button 
above the scrollbar to the right.

The rack maximize button.

Creating Devices
To create a new device, select the desired item on the Create menu. This menu 
is available both on the main menu bar and on the context menus (see page 38 
for an introduction to context menus).

D The new device is added directly below the currently selected de-
vice in the rack.
If no device is selected, the new device is added at the bottom of the rack.

D When you add a new device, Reason attempts to route it in a logical 
way.
For an introduction to the auto-routing features, see page 51. 

D A new track will automatically be created in the sequencer, and 
routed to the new device.
The track will have the same name as the device. MIDI input will also auto-
matically be set to the new track, allowing you to immediately play the cre-
ated device via MIDI (see page 54). 

! By default, this only applies to instrument devices, not to mixers or 
effect devices. If you hold down [Option] (Mac) or [Alt] (Windows) 
when you create the device, the opposite is true, i.e. mixers and ef-
fect devices get new tracks but instrument devices don’t.

The Create menu on the main menu bar 
and on a context menu.
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Selecting Devices
Some operations (e.g. cutting, copying and deleting devices) require that you 
select one or several devices in the rack. This is done according to the following 
rules:

D To select a single device, click on it in the rack.
The selected device is displayed with a colored border (based on the color 
scheme selected for your operating system).

D To select several devices, hold down [Shift] and click.
In other words, [Shift]-clicking a device selects it without de-selecting any 
other selected devices.

D To de-select all devices, click in the empty space at the bottom of 
the rack.

D To de-select one of the selected devices, hold down [Shift] and click 
on it.
Any other selected devices remain selected.

D You can also use the up and down arrow keys on the computer key-
board to select the device directly above or below the currently se-
lected one.
When you use this method, Reason will automatically scroll the rack so that 
the selected device is fully visible. This is a quick way to “step through” the 
rack. Narrow devices (e.g. half-width devices such as the effects) are or-
dered left-to-right, i.e. pressing the down arrow key will step through the de-
vices from left to right before moving on the next device row.

D If you hold down [Shift] when using the up or down arrow keys, the 
currently selected device will remain selected.
This allows you to select a range of devices.

Adjusting a parameter in a device will automatically select it. In other words, you 
never have to select a device before making settings.

Deleting Devices
To delete one or several devices, select them and use one of the following meth-
ods:

D Hold down [Command] (Mac) or [Ctrl] (Windows) and press [Back-
space] or [Delete].

D Select “Delete Device” from the Edit menu or the device context 
menu.

You can also automatically delete devices when you delete sequencer tracks: If 
there is a single sequencer track routed to a device, and you delete this track, 
you will be asked whether you want to delete the device as well (see page 63).

! If you delete a device connected between two other devices, the 
connection between these is automatically preserved.

! The Hardware Interface device at the top of the rack cannot be re-
moved.

Reordering Devices
You can rearrange the devices in the rack by moving them, in the following way:

1. If you want to move more than one device at the same time, select 
the devices.

2. Click in the “handle” area of one of the devices.
For full width devices, this is the area to the left and right of the panel (be-
tween the rack fittings); for smaller devices you can click anywhere outside 
the actual parameters.

3. With the mouse button pressed, drag the device(s) up or down in 
the rack.
A thick red vertical line indicates where the device(s) will be positioned. 
Note that the red line can be to the left of a device (indicating that the moved 
device will be inserted before the other device) or to the right of a device (in-
dicating that the moved device will be inserted after the other device). 
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In this example an RV-7 reverb device is moved:

4. Release the mouse button.
The device(s) are moved to the new position and the other devices in the 
rack are adjusted to fill up the “gaps”.

! Note that if you start to move a device but change your mind, you 
can abort the operation by pressing [Esc] while keeping the mouse 
button pressed.

D If you hold down [Shift] when you move a device, Reason will at-
tempt to automatically re-route it.
See page 51 for more info on auto-routing.

! Moving devices in the rack does not affect the order of the se-
quencer tracks and vice versa.

Duplicating Devices
To make a copy of a device in the rack, hold down [Option] (Mac) or [Ctrl] (Win-
dows) and drag it to a new position.

D If you hold down [Shift] when you duplicate the device, Reason will 
attempt to automatically route it, just as when you move devices.
See page 51.

Cut, Copy and Paste
Selected devices can be moved or duplicated using the Cut, Copy and Paste 
Device functions on the Edit menu or device context menu. For example, this al-
lows you to copy one or several devices (such as an instrument device and all its 
insert effects) from one Reason Song to another. The following rules apply:

D Cut and Copy affects all selected devices, and work according to the 
standard procedures.
That is, Cut moves the devices to the clipboard (removing them from the 
rack) while Copy creates copies of the devices and puts these on the clip-
board, without affecting the rack.

D When you Paste devices, these are inserted into the rack below the 
currently selected device.
If no device is selected, the pasted devices will appear at the bottom of the 
rack.

D If you Copy and Paste several devices, the connections between 
these are preserved.

D If you hold down [Shift] when you Paste a device, Reason will at-
tempt to automatically route it. 
The rules are the same as when moving or duplicating devices by dragging. 
See page 51.

In this case, the red line indicates that the reverb device will be inserted to the left of the 
phaser.

This is the result. Note that the filter device is moved to the left, to fill out the gap.

In this case, the red line indicates that the reverb device will be inserted to the right of the 
chorus/flanger. 

This is the result. All three devices are moved to the left, to fill out the gap.



MANAGING THE RACK 51

A Quick Note on Routing
! This section only describes the basics in routing. For detailed de-

scriptions of routing procedures and possibilities, see the elec-
tronic documentation.

Reason allows for extremely flexible routing of audio and control signals be-
tween the devices in the rack. Basically, routing can be done automatically or 
manually:

Automatic Routing
Auto-routing means that Reason makes all basic audio connections for a device, 
in one go. As mentioned on the previous pages, auto-routing is automatically 
performed when you create a new device, and when you move, duplicate or 
paste devices with [Shift] pressed. 

✪ If applicable, auto-routing is automatically done in stereo.

Creating Mixers

D The first created mixer device will be routed to the Stereo inputs on 
the Hardware Device.
If you create more mixers, they will be connected in series using the mixers’ 
Chaining connections (see the electronic documentation).

Routing a device to the Mixer

D When you create an instrument device (synth, sampler, drum ma-
chine or loop player) it is automatically routed to the first available 
mixer channel.
This makes it immediately available for use.

Routing a Send Effect to the Mixer

D When you have a mixer selected and create an effect device, it will 
be connected as a send effect (to the first free Aux Send/Return).
Examples of effects that lend themselves well for use as send effects are re-
verb, delay and chorus.

Routing an Effect Directly to a Device (Insert)

D When you have an instrument device selected and create an effect, 
that effect will be connected as an insert effect. That is, the signal 
from the device will pass through that effect and to the mixer.
Examples of effects that work well as inserts are distortion, compression and 
phaser.

Auto-routing Devices after they have been Created

Here follows some additional rules about auto-routing devices that are already in 
the rack:

D To reroute a device already in the rack, you can select it and use 
Disconnect Device and Auto-route Device, both on the Edit menu.

D If you delete a device connected between two devices, the connec-
tion between the two remaining devices is automatically preserved.
A typical example would be if you have an effect device, connected as an in-
sert effect between a synth and a mixer. If you delete the effect, the synth will 
be routed directly to the mixer.

D When you move a device, connections are not affected.
If you instead would like the program to re-route the device according to its 
new location in the rack, hold down [Shift] when you move it.

D When you duplicate devices (by dragging) or use copy and paste, 
the devices are not auto-routed at all.
If you would like them to be automatically routed, hold down [Shift] when you 
perform the operation.
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Manual Routing
To connect devices manually, you need to flip the rack around to see the back. 
This is done by pressing [Tab] or selecting “Toggle Rack Front/Rear” from the 
Options menu.

On the back of each device you will find connectors of two different types: audio 
and CV (Control Voltage, used for controlling parameters - see the electronic 
documentation). Audio inputs and outputs are shown as large “quarter inch” 
jacks, while CV input and output jacks are smaller. For now, we stick to audio 
connections.

! When the back is shown, you can still navigate in the rack by scroll-
ing, by using the computer keyboard, etc. (see page 48).

There are two ways to route audio from one device to another: by connecting 
“virtual patch cables” between inputs and outputs, and by selecting connections 
from a pop-up menu:

Using Cables

! For the cables to be visible, the option “Show Cables” must be acti-
vated on the Options menu. See below.

1. Click on the desired input or output jack on one of the devices, and 
drag the pointer away from the jack (with the mouse button 
pressed).
A loose cable appears.

2. Drag the cable to the jack on the other device.
When you move the cable end over a jack of the correct type (audio/CV, in-
put/output) it will be highlighted to show that a connection is possible. 

3. Release the mouse button.
The cable is connected. If both input and output are in stereo and you con-
nect the left channels, a cable for the right channel is automatically added.

! Dragging a cable to make a connection can be aborted by pressing 
[Esc] while keeping the mouse button pressed.

✪ To give a better overview of the connections, the cables have differ-
ent colors. Connections to or from effect devices are different 
shades of green, other audio connections are different shades of 
red and CV connections are different shades of yellow.

Audio connectors

CV connectors
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D You can change an existing connection in the same way, by clicking 
on one end of the cable and dragging it to another connector.

Using pop-up menus

1. Click (or right-click) on a connector.
A pop-up menu appears, listing all devices in the rack. 

2. Move the pointer to the desired device (the device to which you 
want to create a connection).
A submenu appears, listing all suitable input/output connections. For exam-
ple, if you clicked on an audio output on a device, the hierarchical submenus 
will list all audio inputs in all other devices.

D If a device is greyed out on the pop-up menu, there are no connec-
tions of the suitable kind.

3. Select the desired connector from the submenu.
The connection is created.

Disconnecting Devices

Again, there are two ways to disconnect devices:

D Click on one end of the cable, drag it away from the jack and drop it 
anywhere away from a jack.

or 

D Click on one of the connectors and select “Disconnect” from the 
context menu that appears.

Hiding and Showing Cables

You can choose whether you want the patch cables to be visible or not, by acti-
vating or deactivating the Show Cables item on the Options menu. When the 
cables are hidden, connectors in use are indicated by a colored dot:

Checking Connections

You can check to which device a jack is connected. This is especially useful if 
the patch cables are hidden, but it is also practical if you have a lot of cables or 
if the two devices are far from each other in the rack: 

D Position the pointer over a connector and wait a moment.
A tool tip appears, showing the device and connector in the other end.

These cables are green, indicating effect device connections.

This cable is yellow, indicating a 
CV connection.

These cables are red, indicating connections 
between instruments and mixer devices.
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Routing MIDI to a Device
There are several ways to send MIDI from an external MIDI controller to a Rea-
son device, as described in the electronic documentation. However, in this book 
we stick to the most common method: to route MIDI via the sequencer.

With this method, incoming MIDI (e.g. from your MIDI keyboard) is sent to one of 
the tracks in Reason’s sequencer. The sequencer will then pass it on to a device 
in the rack (the device to which the track is routed). This way, you can select dif-
ferent devices for MIDI playback by directing the incoming MIDI to different 
tracks in the sequencer.

Proceed as follows:

1. Make sure your MIDI controller is connected to the correct MIDI in-
put on your computer, and sends on the correct MIDI channel.
This should be the MIDI port and channel you specified for the sequencer in 
the Preferences-MIDI dialog, as described on page 16.

2. In the sequencer, locate the track that is connected to the device 
you want to play.
If you are uncertain, you can pull down the Out pop-up menu for each track 
and check to which device they are routed.

3. Click in the In column for the track.
A MIDI symbol is displayed, to indicate that this track will transfer incoming 
MIDI to its device.

4. Play the MIDI controller to hear the sound of the device.

✪ On the panel of some instrument devices you will find a Note On in-
dicator. This blinks to indicate incoming MIDI notes.

Naming Devices
Each device has a “tape strip” showing the name of the device. When you cre-
ate a new device it is automatically named according to the device type, with an 
index number (so that the first Subtractor synthesizer you create is called “Synth 
1”, the next “Synth 2” and so on). If you like, you can rename a device by clicking 
on its tape strip and typing a new name (up to 16 characters).

For devices connected to a mixer, the device names are automatically reflected 
on the vertical tape strips for the corresponding mixer channels (next to the mixer 
channel faders). Similarly, tape strips below the Return knobs show the names 
of the effect devices connected to the corresponding Return inputs.
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Note that the mixer channel tape strips show the name of the device directly 
connected to the mixer! This means that if you have an instrument device routed 
through an insert effect, the mixer channel tape strip will show the name of the 
insert effect device (as this is the device directly connected to the mixer chan-
nel). In this case, you may want to rename the insert effect device, to indicate the 
connected instrument.

The relation between device names and track names

When you create an instrument device, it automatically gets a track in the se-
quencer, with the same default name. Renaming a device will also rename the 
corresponding sequencer track, and vice versa, if the following conditions are 
met:

• The device and its track has the same name.
• There is only one track connected to the device.

Often, having the same name for the device and the track is the most practical 
arrangement, since it makes it easier to keep track of which track plays what. 
Should you want to rename the track or device independently, you need to dis-
connect the track from the device, rename and connect it again. How to connect 
a track to a device is described on page 62.

Folding and Unfolding
If you don’t need to make settings for a device, you can fold it to make the rack 
more manageable and avoid having to scroll a lot. This is done by clicking the ar-
row to the left of the device.

To unfold the device, click the arrow again.

D In rack rows with devices of smaller width, the fold/unfold arrow is 
placed to the left of the leftmost device and affects all devices in 
the row.

D If you hold down [Option] (Mac) or [Alt] (Windows) and click the ar-
row of an unfolded device, all devices in the rack will be folded.
Conversely, [Option]/[Alt]-clicking the arrow of a folded device will unfold all 
devices.

D For folded devices, no parameters are shown and you cannot make 
routing adjustments on the backside of the rack as long as the de-
vices are folded.
However, if you want to make a connection to a folded device, you can drag 
a cable to it and hold it there for a moment. This will cause the folded device 
to automatically unfold and let you make the connection. 

D Folded devices can be renamed, moved, duplicated and deleted just 
like unfolded devices. 

D For devices that use patches, you can select patches in folded mode 
as well.

D Playback is not affected by folding.
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7 D The Sequencer - Basics
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About the Sequencer
The sequencer is your main composition tool in Reason. This is where you 
record notes, controllers, device parameter automation and pattern changes.

In this chapter you will find descriptions of all basic procedures; recording, play-
ing back and handling sequencer tracks. For descriptions of editing, quantizing, 
using groups, etc., please refer to the electronic documentation.

The relation between the Sequencer and the 
Rack
In the sequencer, data is recorded and played back on tracks (much like tracks 
on a multi-track tape recorder).

A track can be connected to an instrument device in the rack, so that data on the 
track is sent to the device on playback. Each track can only be connected to one 
device at a time, but it is possible to have several tracks that all play the same 
device. Note also that when renaming a sequencer track (see page 61), the de-
vice to which it is connected automatically gets the same name - and vice versa.

It is possible to have tracks that are not connected to any device. Notes on a dis-
connected track will not be heard on playback (since there is no device to play 
them). Similarly, it is possible to have instrument devices without sequencer 
tracks.

The Main Sequencer vs. Pattern Sequencers

As described in the chapter “Using Pattern Devices”, the main sequencer inter-
acts with the built-in sequencers in pattern devices in the following ways:

D The sequencer and all devices use the tempo, as set on the trans-
port panel.

D If you start playback for the main sequencer (on the transport 
panel), all pattern devices will automatically start as well.
That is, provided the pattern sequencer isn’t disabled for a device (see page 
72).

D Pattern changes will always happen at the start of a bar in the main 
sequencer (regardless of the pattern lengths).
This only applies to pattern changes made “live” on the device panel. Pattern 
changes played back from the sequencer will happen at their exact position. 
See the electronic documentation.

For details, see page 72.

The tracks are 
listed in the 
track list.

Recorded events on different tracks. 

The icons in this column indicate to which device type each track is connected.

The selected track “El 
Bass” is also connected 
to the device named “El 
Bass”
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Sequencer window 
handling

The sequencer area below the rack.

The basic window techniques in Reason have been described on page 40. Here 
is a quick run-through:

D You can adjust the size of the sequencer area by dragging the di-
vider between the sequencer and the rack.

D Clicking the maximize button in the upper right corner will make 
the sequencer area fill the whole document window.

The sequencer maximize button.

D When editing the contents of a sequencer track, the right part of the 
sequencer area can be divided into different lanes.
Typically, you would view the note information in one lane, controller curve in 
another lane, etc. You can adjust the size of the lanes by dragging the divid-
ers between them.

Here, the key lane, velocity lane and a controller lane are shown.

D You can scroll and change magnification in a number of ways, in-
cluding standard scroll bars and horizontal and vertical zoom con-
trols, as well as with the Magnifying Glass tool, the Hand tool and a 
mouse with a scroll wheel (see page 41).
Where applicable, different areas in the sequencer have separate scrollbars 
and zoom controls.

D You can also adjust the horizontal magnification in the sequencer 
area by holding down [Command] (Mac) or [Ctrl] (Windows) and 
pressing [+] or [–] (on the standard part of the computer keyboard, 
not on the numeric keypad).
[Command]/[Ctrl]-[+] zooms in while [Command]/[Ctrl]-[–] zooms out.
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Working with the sequencer in a separate 
window
The sequencer window can be detached from the rack and used in a separate 
window. This could be useful for instance if you are working with a large number 
of tracks or if you are viewing many sequencer lanes at once. Detaching the se-
quencer will then make it possible to view all tracks or lanes at once without hav-
ing to resize the sequencer or scroll the view up and down to focus on a certain 
track or lane

The separate sequencer window can be positioned and resized freely both hori-
zontally and vertically using the basic windows techniques described on page 
40.

D To detach the sequencer from the rack, either click the correspond-
ing button in the top right corner of the rack, or pull down the Win-
dows menu and select “Detach Sequencer Window”.

D Similarly, to reattach the sequencer window to the rack, either se-
lect “Attach Sequencer Window” from the Windows menu or click 
the button.
Note that the button for detaching the sequencer window is only available in 
the rack. The button for reattaching the sequencer though, is available both 
in the rack and in the sequencer.

The Attach Sequencer button on the sequencer and, in the background, on the rack.

! Another way of reattaching the sequencer window is by closing it. 
Note also that the rack is still the “main” window for the song, 
which means that closing the song will close the sequencer window 
as well.

About the Transport

You’ll notice that when detaching the sequencer from the rack, there will be two 
instances of the transport on the screen - one in the rack and one in the se-
quencer window. This is for convenience since it allows you to control playback 
and recording regardless of which window is the active one.

Should you wish however, you can fold one of the transports in the same manner 
as with any other device in Reason. Folding and unfolding devices is described 
on page 55.

✪ To make the rack or the sequencer the active window when they are 
separated, you can use the key commands [Command]-[1] (Mac)/
[Ctrl]-[1] (Windows) and [Command]-[2] (Mac)/[Ctrl]-[2] (Windows) 
respectively.

Click this button...

...to open the sequencer in a 
separate window.
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A note about using Reason with two monitors

If you have a computer system with two monitors, you can do the following:

D Use one monitor for viewing and managing the rack only.

D Detach the sequencer as described above, and dedicate one of your 
monitors to the sequencer only.

To be able to use two monitors, you must have an operating system and a graph-
ics card that supports it.

Please refer to the documentation for your operating system and possibly the 
graphics card for instructions on how to set up your system for using two moni-
tors.

Managing Tracks
Creating Tracks
As described on page 48, tracks are automatically created when you create in-
strument devices in the rack. Still, you may need to create additional tracks (e.g. 
for recording effect device automation - see the electronic documentation):

D To create a new sequencer track, pull down the Create menu and 
select Sequencer Track (or select Create Sequencer Track from the 
context menu in the sequencer).
The new track will appear below the currently selected track in the track list. 
Initially, it will not be connected to any device (see below).

D You can also create a new sequencer track specifically for a device 
by using the Create Sequencer Track for Device item on the device’s 
context menu.
This works the same as when creating a new device, i.e. the new track is 
connected to the device and has the same name.

Naming Tracks
You can rename a track by double clicking on its name in the track list and typing 
in a new name. Note:

D If the track is connected to a device, the device will be renamed too.
Typically, after creating a new device, you can rename its sequencer track, 
automatically changing the name of the device. The reverse is also true. That 
is, renaming a device will also change the name of its sequencer track.

Selecting Tracks
To be able to manipulate a track or edit its contents, you need to select it. You 
select a track by clicking on its name in the track list.

Selected tracks are highlighted in the list.

Selecting a track will automatically scroll the rack to bring the corresponding de-
vice into view.
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D You can also select the next or previous track in the list by using the 
up and down arrow keys on the computer keyboard.

D It is possible to select several tracks, by pressing [Shift] and click-
ing. 
This allows you to e.g. move or delete several tracks in one go. However, you 
can only edit the contents of one track at a time (the top selected track will 
be edited - see the electronic documentation).

! Don’t confuse selecting a track with routing MIDI to a track (see be-
low).

Routing MIDI to a Track
The normal way of routing MIDI to a device in the rack is to go via the sequencer. 
When MIDI is routed to a track in the sequencer, the notes and controller data 
are automatically echoed to the corresponding device (the device to which the 
track is connected - see below).

D To route incoming MIDI to a track, click in the In column (to the left 
of the track name).
A MIDI connector symbol appears, indicating that the track will receive MIDI 
(provided that you have selected a MIDI Input port for the sequencer in the 
Preferences-MIDI dialog, as described on page 16).

You cannot route MIDI to several tracks at the same time - clicking in the In col-
umn for another track will move the MIDI connector symbol. 

Disconnecting MIDI In

You can turn off incoming MIDI altogether by clicking on the MIDI connector 
symbol so that it disappears.

Connecting a Track to a Device
To the right of the track name you will find the Out column. During playback (and 
when you play Reason via MIDI, this setting determines to which device each 
track will send MIDI data.

D To connect a track to a device in the rack, pull down the pop-up 
menu in the Out column and select one of the devices.

The symbol in the Out column indicates to which device type each track is connected.

✪ When you create an instrument device, a track is automatically cre-
ated and connected to the new device.

Moving Tracks
To move a track to another position in the list, click on the track name and drag 
it up or down. To move several tracks at once, select them, click on one of them 
and drag.

! The order of the tracks in the sequencer is independent of the de-
vice order in the rack.

Duplicating Tracks
To make copies of tracks, complete with all recorded data, use any of the follow-
ing methods:

D Hold down [Option] (Mac) or [Ctrl] (Windows) and drag the track to 
a new position in the track list.

D Bring up the context menu for the track and select Duplicate Track.
To bring up the context menu, [Ctrl]-click (Mac) or right-click (Windows) on 
the track in the track list.

! Note that a duplicated track will be routed to the same device as the 
original. You may want to mute one of the tracks or connect it to an-
other device to avoid double notes, etc.
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Deleting Tracks
To delete one or several tracks, select them and press [Backspace] or [Delete].

D If the track to be deleted (and this track only) is connected to a de-
vice, the following alert message will appear:

Select one of the following options:

About the two Views
While the left part of the sequencer area always contains the track list, there are 
two different view modes for the right part: Arrange View and Edit View. You 
switch between the two views by clicking the button in the top left corner of the 
sequencer area. The button changes appearance to illustrate which view is se-
lected.

Arrange View

In the Arrange View, all tracks are shown, with colored bars indicating recorded 
events. Use this mode to get an overview of your arrangement, and when you 
want to perform large scale editing such as rearranging whole sections of your 
song, etc.

Edit View

In the Edit View, you get a close-up look at the recorded events on a single track 
at a time. When the Edit View is selected, the right part of the sequencer area 
can be divided into several horizontal lanes, showing different types of events 
(notes, REX slices, drum sounds, controllers, etc.). This is the view mode of 
choice for fine editing of your recording, for when you want to draw notes, con-
trollers and other events manually.

! For details about editing, see the electronic documentation.

| Option | Description

Delete Delete both the track and the connected device.

Keep Delete the track but keep the device in the rack.

Cancel Do not delete the track or the device.

The Arrange 
view selected.

The Edit 
view selected.
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About the Ruler, Song 
Position and Locators
Regardless of which view mode is selected, you will find a horizontal ruler at the 
top of the sequencer display. This indicates the meter positions, that is, the po-
sitions in bars and beats.

D The numbering and detail of the ruler depends on the horizontal 
magnification.

At a medium zoom setting, odd bars will be shown with a bar number and even bars will 
be indicated by a mark. 

If you have zoomed in fully, each bar will be numbered, and every 1/32 note position will 
be indicated by a mark.

In the ruler, you will also find four different position markers, each with a separate 
“flag”:

✪ The End (E) marker indicates the end of the song. The program uses 
this information when exporting the song as an audio file and when 
you scroll horizontally in the sequencer area. 
Playback or recording will not stop at the End marker. 

Transport Controls - 
Overview
The transport panel is located at the bottom of each song document window. 
This is where you activate playback, recording, fast forward/rewind, etc. Here is 
a brief overview of the controls, to help you find your way in the recording and 
playback procedures on the following pages.

Transport Key Commands

There are fixed computer keyboard combinations for the most important trans-
port functions:

This is the song position, 
indicating at which position 
playback happens. 

This is the End marker. This informs 
Reason about where your song ends 
(see the note below).

This is the left locator. When using the 
Loop mode (see page 68), the left locator 
governs the start position of the loop. 

This is the right locator. When using the 
Loop mode, this governs the end position 
of the loop. 

| Function | Key command

Stop [0] on the numeric keypad or [Return]

Play [Enter] on the numeric keypad

Toggle Stop/Play Space bar

Go to previous bar/Rewind [7] on the numeric keypad

Go to next bar/Fast Forward [8] on the numeric keypad

Record [*] on the numeric keypad or hold 
[Command] (Mac) or [Ctrl] (Windows) 
and press [Return]

Go to Left Locator (Loop Start) [1] on the numeric keypad

Go to Left Locator (Loop End) [2] on the numeric keypad

Stop

Play

Rewind

Fast Forward

Record

Song Position Overdub/Replace switch 
(see page 66)

Loop on/off (see page 68)

Left and Right Locator positions 
(the boundaries of the loop - see 
page 68).
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Setting Up for Recording
Before you can start recording, you need to make some settings:

Tempo and Time Signature
The tempo and time signature settings are located on the transport panel. 

D You can specify any tempo between 1 and 999.999 bpm (beats per 
minute).
The tempo field to the right allows you to fine tune the tempo, in steps of 1/
1000 bpm.

You can also adjust the tempo (in bpm steps) by using the [+] and [–] keys on 
the numeric keypad.

D You set the time signature by specifying a numerator (left value 
field) and a denominator (right value field).
The numerator is the number of beats per bar, and the denominator governs 
the length of a beat.

Click
When you record, it is often necessary to have some sort of rhythmic guide to 
help you keep time. The easiest way is to use the built-in metronome click:

When this is activated, you will hear a click on each beat, with an accent on the 
downbeat of each bar. The click is played back during recording and playback. 
You can adjust the volume of the click by using the Level knob.

✪ Sometimes it might be easier to use a drum machine pattern as a 
rhythmic guide.

Recording
To record MIDI from an external MIDI instrument, proceed as follows:

1. Make sure MIDI is routed to the desired track.
See page 62.

2. Move the song position to where you want the recording to start.
Recording always starts at the song position.

To move the song position, drag the P marker or click directly in the ruler.

✪ You may want to start a few bars early to get time to start playing.

3. Click the record button or press [*] on the numeric keypad.
The record button lights up to indicate “Record Standby” mode.

4. Click the play button or press [Enter] on the numeric keypad.
Recording starts.

5. When you are done, click the stop button or press [0] on the nu-
meric keypad.

Recorded notes are indicated as red “bars” in the Arrange window.

At this point, you may want to move the song position to the beginning of the re-
cording (by rewinding or by moving the song position marker in the ruler), and 
click the play button to listen to what you recorded. You can undo the recording 
if you like.

D It is also possible to activate recording during playback (“punch 
in”), by starting playback and then clicking the record button.
Similarly, you can deactivate recording without stopping playback (“punch 
out”).

The tempo set to 
110.094 bpm.

3/4 time selected.
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Recording more tracks
Once you have recorded something, you can continue recording on other 
tracks, while hearing the first recording play back. Just remember to route MIDI 
to the desired recording track.

D You can change the MIDI routing during recording if you like.
This is especially useful when recording in loop mode: record the first track, 
then click in the In column for the next track you want to record, and so on. 
Everything you record will be played back on the next loop lap.
For more info about the loop mode, see page 68.

Recording more on the same track - Overdub/
Replace
If you like, you can continue recording over the same area on the same track. 
This can be useful for adding elements to a loop, for recording automation of 
multiple controls or for replacing a faulty part of an otherwise good take.

Whether the previous recording is kept or removed depends on the Overdub/
Replace setting.

D In Overdub mode, the new recording is added to whatever was on 
the Track before. 
When you play back, you will hear both recordings. This is the mode to use 
when you want to add elements to an existing recording (e.g. add controller 
data to recorded notes).

D In Replace mode, the new recording replaces any previously re-
corded notes.
Only the notes in the actual recording area are replaced. 

! It’s probably best to use Overdub mode as your default mode, to 
avoid removing material by mistake.

! The Overdub/Replace switch affects notes only - not recorded con-
trollers! See the electronic documentation for details. 

Replacing a section of a previous recording

If you have made a largely successful recording, in which only a section needs to 
be redone, you can use Replace mode for this:

1. Select Replace mode.

2. Start playback at a position before the faulty section.

3. At the start of the section, activate recording.

4. Re-record the section.

5. At the end of the faulty section, deactivate recording or stop.

Playback and Positioning
! If you are using ReWire, transport functions can be handled by ei-

ther application. See the electronic documentation.

Play and Stop
D To play back from the current song position, click the play button or 

press [Enter] on the numeric keypad. 

D To stop playback, click the stop button or press [0] on the numeric 
keypad.

If you click the stop button when the song is already stopped, the song position 
is moved according to the following rules:

• If the song position is to the right of the left locator, it is moved to the left lo-
cator.

• If the song position is at the left locator or to the left of it, it is moved to the 
start of the song.

• If the song position is at the start of the song, nothing happens.

This means you can always click twice on the stop button in stop mode, to return 
to the beginning of the song.
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Positioning

The song position is indicated by the vertical line with the “P” marker in the ruler. 
There are several ways to move the song position:

D Use the rewind and fast forward controls on the transport panel.
This moves the song position in steps of one bar (from its current position). 
That is, if you just click once on the rewind/fast forward button, the song po-
sition will be moved exactly one bar back or forward. To move the song po-
sition several bars, click and hold the mouse button.

D Use the transport key commands on the numeric keypad.
See the table on page 64.

D Click and drag the P marker in the ruler, or click directly in the ruler 
at the desired song position.
The resulting song position takes the Snap value into account, as described 
below.

D Adjust the song position numerically in the value display below the 
transport buttons.
The song position is shown as three digits: bars, beats and sixteenth notes.

About Snap to Grid

The Snap to Grid function (from now on called “Snap”) restricts movement to 
specific positions. This is especially useful when you are editing in the se-
quencer (moving material, creating events, etc), but it will also affect the result of 
moving the song position in the ruler.

To set up and activate Snap, proceed as follows:

1. Pull down the Snap pop-up menu and select a value.
If you select “Bar”, you will only be able to move the song position to the be-
ginning of bars. The other options restrict movement to the corresponding 
note values.

2. Activate Snap by clicking the button next to the pop-up menu.

In this example, Snap is activated and set to quarter notes. This means you can move the 
song position to exact quarter note positions only.

The Snap on/off button.

The Snap value pop-up.
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Using the Loop
In loop mode, the sequencer will repeat a section over and over again, during 
playback or recording. You specify the section to be looped by setting the left 
and right locator:

D Set the left locator (the start of the loop) by dragging the “L” marker 
in the ruler.
Or, you can hold down [Option] (Mac) or [Ctrl] (Windows) and click in the 
ruler.

D Set the right locator (the end of the loop) by dragging the “R” 
marker in the ruler.
Or, you can hold down [Command] (Mac) or [Alt] (Windows) and click in the 
ruler.

! Note that Snap applies when moving the locators in the ruler, just 
as with the song position.

Both locator positions can also be adjusted numerically on the transport panel.

D To activate the loop, click the Loop On/Off button so that it lights 
up, or use the corresponding key command.
On a Mac this is [/], under Windows it’s [÷], both on the numeric keypad.

When you play back in loop mode, and the song position reaches the right loca-
tor, it will immediately jump back to the left locator. This way, the area between 
the locators will be repeated continuously.

✪ Playing back in loop mode is useful to try out mixes and arrange-
ments, rehearse takes, etc. Recording in loop mode can be useful 
for adding elements to a groove, one layer at a time. Just remember 
to select Overdub mode if you are recording several layers on the 
same track!

Mute and Solo
To mute a track means to silence it, so that no data is sent from the track during 
playback. This can be very useful when you are trying out different versions of an 
arrangement, for bringing elements in and out of the mix during playback, etc.

D To mute (silence) a track, click in the M column in the track list.
The notes and events on the muted track will not be heard on playback.

A red cross indicates a muted track.

To unmute the track, click in the M column again. Several tracks can be 
muted at the same time.

D You can also solo a track, by holding down [Option] (Mac) / [Alt] 
(Windows) and clicking in the M column. 
This mutes all other (unsoloed) tracks.

Here, the track Redrum 1 is soloed (indicated by a red frame).

To turn off the solo function for the track, [Option]/[Alt]-click in the M column 
again. Several tracks can be soloed at the same time.

✪ It is possible to change the mute status of tracks while in solo 
mode, by clicking in the M column. The change you make will be re-
flected when you turn off the solo function. 

! Muting a track will not affect the notes played from a pattern se-
quencer in a pattern device! 
For example, if you mute a track that is connected to a Redrum 
drum machine device, the drum pattern played by the device will 
still be heard. However, any notes you have recorded on the track 
(using the Redrum as a “sound module”) will be muted, as will any 
recorded pattern changes.
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What else can I do in the 
sequencer?
This chapter has only touched briefly on the capabilities of the sequencer. In the 
electronic documentation you will find detailed descriptions of the following se-
quencer functions and procedures:

• Recording pattern changes and control automation.
• Rearranging recorded material in the Arrange View.
• Editing recorded notes, controllers and pattern changes.
• Quantizing and using grooves.
• Manual creation of notes and controllers.
• Using groups.
• Importing and exporting MIDI files.
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About this chapter
As of this writing, Reason includes two pattern-based devices: the Redrum 
drum computer and the Matrix Pattern Sequencer (additional pattern devices 
may be added in upcoming versions). While these two devices are very different 
in most ways, they handle patterns following the same basic rules, as described 
in this chapter.

! For details about the respective devices, see the electronic docu-
mentation.

What are Pattern Devices?
A pattern device contains a built-in pattern sequencer. Unlike the main se-
quencer in Reason, a pattern sequencer repeatedly plays back a pattern of a 
specified length. The typical example in the “real world” (as well as in Reason) is 
a drum machine which plays drum patterns, usually one or two bars in length.

Having the same pattern repeat throughout a whole song may be fine in some 
cases, but most often you want some variations. The solution is to create several 
different patterns and program pattern changes (automatic switching from one 
pattern to another) at the desired positions in the song.

How Pattern Devices integrate with the main 
Sequencer
The built-in pattern sequencer in a pattern device interacts with the main Reason 
sequencer in the following ways:

D The tempo set on the transport panel is used for all playback.

D If you start playback for the main sequencer (on the transport 
panel), all pattern devices will automatically start as well (provided 
their pattern sequencers haven’t been disabled - see below).

D You can also run a pattern device separately (without starting the 
main sequencer or other pattern devices) by clicking the Run button 
on the device panel.
This starts the built-in pattern sequencer in the device. To stop playback, 
click the Run button again or click the Stop button on the Transport panel.

The Run button on the Redrum drum computer.

D If you are running a pattern device separately and start playback of 
the main sequencer, the pattern device will automatically restart in 
sync with the sequencer.

D Pattern changes can be controlled by pattern change events in the 
main sequencer.
In other words, you can record or create pattern changes in the main se-
quencer, and have them occur at the correct position on playback.

D If the pattern device has a built-in sound source (such as Redrum), 
this can also be played by the main sequencer, or via MIDI.
You can combine the built-in pattern playback with playback from the main 
sequencer or via MIDI. For example, this allows you to add variations or fills 
to a basic pattern.
It is also possible to disable the pattern sequencer totally, converting the de-
vice to a pure sound module. This is done by deactivating the Enable Pattern 
Section switch.

Read more about controlling devices from the main sequencer on the electronic 
documentation.
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Selecting Patterns
Each pattern device has 32 pattern memories, divided into four banks (A, B, C, 
D).

The Bank and Pattern buttons for the Matrix pattern sequencer.

D To select a pattern in the current bank, click on the desired Pattern 
button (1-8).
If you like, you can assign computer key commands and/or MIDI messages 
to pattern selection. See the electronic documentation.

D To select a pattern in another bank, first click the desired Bank but-
ton (A, B, C, D) and then click the Pattern button.
Nothing happens until you click the Pattern button.

The pattern change takes effect on the next downbeat according to the time sig-
nature set in the transport panel.

The Pattern Mute Switch

The Pattern Mute switch in the Redrum and the Matrix.

Next to the Bank and Pattern buttons you will find an additional switch, which is 
normally activated. If you click this to turn it off, the pattern playback will be 
muted, starting at the next downbeat - exactly as if you had selected an empty 
(silent) pattern. For example, this can be used for bringing different pattern de-
vices in and out of the mix during playback.
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Programming a Pattern
The actual programming procedure differs for the different devices (see the 
electronic documentation for descriptions of the Redrum and Matrix, respec-
tively).

However, some basic principles are common for all pattern devices:

Steps

Patterns consist of a number of discrete steps. For each step, you can enter a 
note, a CV value or various properties, depending on the device. When you run 
the pattern, each step will be played back in turn and will play a sound or send 
out the information programmed for this step. If you have ever used a drum ma-
chine, this will be obvious to you.

Pattern Length

For each pattern, you can specify a length, i.e. how many steps it should contain. 
The maximum pattern length is different for different devices.

The pattern length selector for the Redrum (left) and the Matrix (right).

Pattern Resolution

The pattern resolution determines the length (note value) of the steps. When the 
pattern resolution is set to 1/16, each pattern step will be a sixteenth note, when 
set to 1/8, each step will be an eighth note, etc. 

The Resolution control on the Matrix. As with the pattern length value, you can program 
different resolution settings for different patterns.

If you change the resolution of an existing pattern, the audible effect will be a 
change of pattern playback speed. This may seem strange at first, but if you 
think about it, it’s logical: 

Let’s say you have a 16 step pattern with resolution set to 1/16. The length of 
each pattern step is then one sixteenth note, and the whole pattern plays back 
over a whole 4/4 bar (16 sixteenth notes = one whole bar).

Now, if you change the resolution to 1/32, each step will be a 1/32 note - half its 
original length. There are still sixteen steps. This means that the whole pattern 
plays back over half a bar (16 * 1/32 = 1/2). In other words, the pattern plays 
back at double speed.

Pattern Shuffle

Shuffle is a rhythmic feature, that gives the music a more or less pronounced 
swing feel. It works by delaying all sixteenth notes that fall in between the eighth 
notes.

In Reason, you can activate or deactivate shuffle individually for each pattern in a 
pattern device. However, the amount of shuffle is set globally with the Pattern 
Shuffle control on the transport panel.

The Shuffle on/off switch in the Redrum (left) and the Pattern Shuffle control on the transport 
panel (right).

Straight sixteenth note pattern

Sixteenth note pattern with shuffle.
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Clearing a Pattern
To clear (empty) a pattern, select it and use the Clear Pattern command on the 
Edit menu or device context menu.

! Note that clearing a pattern doesn’t affect the pattern length, reso-
lution or shuffle settings!

Using Cut, Copy and Paste
By using the Cut, Copy and Paste Pattern commands on the Edit menu or de-
vice context menu, you can move or duplicate patterns between devices of the 
same type. The following rules apply:

D Copy Pattern makes a copy of the currently selected pattern and 
places the copy on the clipboard.

D Cut Pattern moves the currently selected pattern to the clipboard.
This is the same as first performing Copy Pattern and then Clear Pattern.

D Paste Pattern copies the pattern on the clipboard to the selected 
pattern location in the selected device.
This overwrites the selected pattern with the one on the clipboard.

Transferring patterns between Reason songs

If you want to copy patterns between different Reason songs, you use copy and 
paste:

1. Open both songs.

2. Select the pattern you want to copy.

3. Select Copy Pattern from the Edit menu or the device context menu.
You can also hold [Command] (Mac) or [Ctrl] (Windows) and press [C] to 
copy.

4. Make the other song active.
This is done by clicking in the song window or by selecting the song from 
the Windows menu.

5. Select the bank and pattern location to which you want to copy the 
pattern.
Note that any pattern already stored in that location will be overwritten!

6. Select Paste Pattern from the Edit menu or the device context 
menu.
You can also hold [Command] (Mac) or [Ctrl] (Windows) and press [V] to 
copy.

✪ If you want to use the same patterns in several songs, you could ei-
ther create a “Pattern Supply” Reason song and copy patterns from 
this, or program the patterns into your Default Song (see page 93).

Pattern Functions
When a pattern device is selected, you will find some specific pattern functions 
on the Edit menu (and on the device context menu). Below the three basic types 
of pattern functions are listed. However, the exact names and functionalities de-
pend on the device type - refer to the electronic documentation for details.

Shift

The Shift functions move the notes in a pattern one step to the left or right, or 
transposes them one semitone up or down (depending on the device). This 
function can be used for interesting rhythmic or melodic effects, or as a way to 
rectify patterns for which the first step isn’t on the proper downbeat. 

Randomize

The Randomize functions create random patterns. These can often be great 
starting points and help you get new ideas.

Alter

The Alter functions modify existing patterns. Note that there must be something 
in the pattern for the function to work on - using an Alter function on an empty 
pattern will not do anything.
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Background
About the Database
Reason songs and patches can contain references to other files on your hard 
disk, namely samples (wave or aiff files), loop files created in ReCycle (REX files, 
see below) and Soundfonts (.sf2 files, see page 79). To keep track of all files, 
Reason makes use of a “database”. If you keep your Reason files within the da-
tabase, Reason can update file paths, automatically search for missing files, etc.

D You specify the search path(s) for the database on the Sound Loca-
tions page in the Preferences dialog on the Edit menu or Reason 
menu, as described on page 17.
You can specify up to four different search paths. However, it is normally 
enough to specify a single path, since all underlying folders are automatically 
included in the database. Use the additional paths if you use more than one 
hard drive, CD-ROM drives etc. (see also the note about finding ReFills on 
page 80).

An example of the database. If the folder “Reason Sounds” is specified as search path, 
all its subfolders are automatically included in the database.

! It is possible to select the root of a hard disk as search path, thus 
making the database contain all files on your hard disk. However, 
this will make search times much longer, since Reason will have to 
look at a lot of unnecessary files. Generally, to keep things as 
snappy as possible you should avoid having files unrelated to Rea-
son in your search paths.

About ReFills
A ReFill is a kind of component package for Reason which can contain patches, 
samples, REX files, Soundfonts and demo songs. If you like, you could compare 
ReFills to ROM cards for a synthesizer. On your computer, ReFills appear as 
large files with the extension “.rfl”.

All sounds included with Reason are embedded in a huge ReFill called “Reason 
Factory Sound Bank” (which was either installed on your hard drive or kept on 
the Factory Sound Bank CD, depending on the choice you made during installa-
tion - see page 10). You can also download ReFills from other Reason users on 
the Internet, purchase them from sample manufacturers, etc.

✪ Samples (Wave and AIFF files) are compressed to about half their 
original file size when stored in ReFills.

In Reason, you can use the browser to list and access the embedded sounds 
and other components within the ReFills. just as if the ReFills were folders on 
your hard disk. 

Furthermore, if a song makes use of components from ReFills, Reason will tell 
you which ReFills are required.

Double clicking on the ReFill in the browser...

...opens it for navigation, just like a folder.



THE BROWSER 79

Reason File Formats
The following table lists the file formats that you can browse and open using 
Reason’s browser:

| File type | Extension | Description

Song .rsn This is the main document format in Reason. It 
contains your music and the setup of the rack, 
along with references to any used samples and 
loops (or it can contain the actual samples and 
loops, if you have made the song “self-con-
tained”).

Published 
Song

.rps A published song is a self-contained song in-
tended for playback only. It cannot be changed, 
its components cannot be extracted and it is not 
possible to export it as an audio file.

Subtractor 
Patch

.zyp This is a patch for the Subtractor synth device, 
containing all panel settings. You store your synth 
sounds by saving Subtractor patches.

Malström 
Patch

.xwv This is a patch for the Malström synth device, con-
taining all panel settings. You store your synth 
sounds by saving Malström patches.

NN19 Sam-
pler Patch

.smp This is a patch for the NN19 Sampler device, con-
taining references to and settings for all used 
samples, along with panel settings.

NNXT Sam-
pler Patch

.sxt This is a patch for the NNXT Sampler device, con-
taining references to and settings for all used 
samples, along with panel settings.

Redrum 
Patch

.drp This is a patch for the Redrum drum machine de-
vice. It contains information about which drum 
samples are used, along with all drum sound set-
tings. In effect, a Redrum patch is a stored drum 
kit.

RV7000 
Patch

.rv7 This is a patch for the RV7000 reverb effect, con-
taining all panel settings.

Scream 4 
Patch

.sm4 This is a patch for the Scream 4 distortion effect, 
containing all panel settings.

REX files .rx2, .rcy or 
.rex

REX files are created in another Propellerheads 
application, the ReCycle loop editor. They contain 
audio loops chopped into slices, with one slice for 
each significant beat in the loop. By loading a 
REX file into the Dr. Rex Loop Player device, you 
can play back the loop in virtually any tempo (with-
out affecting the pitch), manipulate individual 
beats in the loop, extract timing info, etc.
Note that you can also load REX files into the 
samplers and the Redrum drum machine.

Samples .wav or .aif The NN19 Sampler and the Redrum drum ma-
chine play back samples, in Wave or AIFF format 
with support for a large number of resolutions and 
sample rates. You can use files of different for-
mats in the same device - one drum sound can be 
an 8-bit sample, the next a 16-bit sample, etc.

Soundfont 
Bank

.sf2 The Soundfont format was co-developed by E-mu 
Systems and Creative Technologies and is used 
with many audio cards and software synthesizers. 
SoundFont banks store wavetable synthesized 
sounds, allowing users to create and edit multi-
sampled sounds in special Soundfont editing pro-
grams. The Soundfonts can then be played back 
in wavetable synthesizers, typically on audio 
cards, thereby effectively turning an ordinary 
sound card into a sampler.
The NN-XT and NN19 Samplers and the Redrum 
drum machine allow you to browse and load 
Soundfonts. Regardless of which editing program 
was used to create them, these banks are simi-
larly and hierarchically organized , with folders for 
instruments, presets, samples etc. The NN-XT, 
NN19 and the Redrum lets you load individual 
samples and presets from a Soundfont bank, but 
not the complete Soundfont.

| File type | Extension | Description
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The Browser
The browser is a special file dialog that appears when you open songs or load 
patches, samples or REX files, from within a ReFill or from regular file folders. Its 
appearance varies slightly depending on what type of file you are opening.

The Sample Browser dialog.

Navigating
Using the browser is much like using a regular file dialog, but there are some ad-
ditional features on the navigation toolbar:

Navigation pop-up menu and Up button

This is a regular navigation pop-up menu, listing all folders hierarchically above 
the current folder. Select a folder from the pop-up menu to go there, or click the 
Up button to go the closest folder above the current one.

Desktop button

The desktop button in the Windows version (left) and the Macintosh version (right).

Clicking this button takes you to the desktop of your computer. In the main file 
display, all available drives (hard disks, floppy drives, CD drives and mapped net-
work drives) will be listed. To open a drive or a folder, double click on it in the file 
display.

Database folder buttons

While you can get to the database by starting at the desktop and navigating your 
way down, the database folder buttons offer a quicker way: Clicking any of these 
buttons takes you directly to the corresponding database folder (search path 1-
4 respectively, as specified on the Preferences-Sound Locations page). From 
there, you can open subfolders in the main file display, or navigate to a higher 
folder using the navigation pop-up.

! The folder button for which you haven’t specified a path are greyed-
out (disabled).

Find All ReFills button

Clicking this button will make the program look for all available ReFills and list 
them in the main file display.

The ReFills are listed together, even though they may be in different folders on your hard disk.

File and 
folder list

Navigation toolbar

Info area
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If you double click on a ReFill in the list, you can navigate “within” the ReFill and 
select songs or sounds for opening, just as if they were separate files on disk.

! When you click the Find All ReFills button, Reason will look for Re-
Fills in the root folder(s) of the database, in the Reason program 
folder and on any CD in the CD-ROM drive (regardless of whether 
the CD-ROM drive is specified as a database search path or not).

Re-scan button

Click this button to have Reason re-scan the currently shown folder and update 
the file display. Use this if you have changed the contents in a folder while the 
browser was open, if you have added a new disk or CD-ROM, etc.

Getting Info
The area to the right of the file display is the info area. This will show information 
about the item that is currently selected in the file display. Exactly which informa-
tion is shown depends on the file type. For example, the info area for samples or 
REX files contains information about the file format and length of the selected 
file, while the song info area displays comments from the author (Song Informa-
tion, see page 91), etc. If the selected file is part of a ReFill, this will be indicated 
regardless of the file type. For details about the info area, see the electronic doc-
umentation.

The Preview function
When browsing REX files or samples, you can audition files before you choose 
to load one. This is done in the following way:

D Select the file in the file list and click the Preview - Play button to 
the right.
The file is played back. During playback, the Play button is relabeled to 
“Stop” - click this to stop playback.

D You can also activate the Autoplay checkbox and simply select the 
file you want to audition.
The selected file is automatically played back. Again, click the Stop button to 
stop playback.

Opening files
When you have navigated to the desired folder (on your hard disk or within a Re-
Fill) and located the desired file, you open it by double clicking it in the file dis-
play or by selecting it and clicking the Open button.

! The browser will only display files of the relevant type. For example, 
if you have selected the “Browse Synth Patches” function for a Sub-
tractor synth device, only synth patches will be listed.

✪ When browsing for a specific file in a folder, you can go to the 
folder and then press the first letter of the desired file on the key-
board. E.g. if you want to load a sample called “Tabla”, you can 
press the letter “T”. The browser will then automatically select the 
first file in the folder that starts with the letter T, which in this case 
may well be precisely the file you want.

Handling Missing Sounds
Sampler patches, drum machine patches and Soundfonts contain references to 
samples - files on your hard disk. The same is true for songs that contain sam-
ples (in sampler or drum machine devices) or REX files. If any of these files have 
been moved, renamed or removed when you try to open the patch or song, Rea-
son will alert you that files are missing:
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Click one of the four buttons:

The Missing Sounds dialog

This dialog appears if you clicked the Open Dialog button in the previous dialog, 
or if you clicked the Search & Proceed button but the program couldn’t find all 
missing sounds.

The main display in the dialog lists all missing files. The four columns show the 
following properties:

Selecting

The Replace and Auto Search functions (see below) are performed on the files 
that are selected in the list. This allows you to replace some files manually (nec-
essary if the files have been renamed or are outside the database), have the pro-
gram find other files automatically and skip the rest of the files.

D To select a file, click on it in the list.
You can use [Shift] (Mac) or [Ctrl] (Windows) to select several files.

D To select all files in the list, click the Select All button.
When the dialog first appears, all files in the list are selected.

Auto Search

If you click the Auto Search button, Reason will search for the selected files in all 
database folders. If the program finds a file with the matching name and file type, 
the new path is stored in the song/patch and the file is shown as “Replaced” in 
the Status column.

D Since the file search looks at the file names, files that have been re-
named will not be found!
This also means that if your database contains several files with the same 
name, the wrong sounds may be found.

Replace

Clicking the Replace button opens the browser dialog, allowing you to manually 
locate each missing file. This allows you to use files outside the database or files 
that have been renamed. The browser dialog will appear once for each selected 
file in the list.

| Option: | Description:

Search & Pro-
ceed

Reason will search for the missing files in all database folders.
• If all files are found, the song or patch will be opened 

without further ado.
• If one or more files cannot be found, the Missing Sounds 

dialog will appear (see below).
Note that the file search will look at the file names only - files 
that have been renamed will not be found!

Proceed The song or patch will be opened, with sounds missing. This 
means that sampler patches, drum machine patches and/or 
loop players will not play back correctly.
On the device panels, missing samples are indicated with an 
asterisk (*) before the file names:

Open Dialog Opens the Missing Sounds dialog (see below).

Cancel Cancels the operation, i.e. no song or patch will be opened.

The “Intruder” sample is missing.

| Column | Description

Device Shows the name of the device in which the missing sound is used, 
along with a device type icon.

Sound Shows the name of the missing file.

Part of Re-
Fill/Sound-
font

If the missing file is part of a ReFill, or a Soundfont within a ReFill, 
this column shows the name of the ReFill/Soundfont If there is an 
URL (Internet address) associated with a ReFill, you can download 
the necessary ReFill(s) from this dialog, as described below.

Status When the dialog appears, all files will have the status “Missing”. 
Files that are found by the auto-search function or manually re-
placed will be indicated as “Replaced”.
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Download ReFill

If a missing sound is part of a ReFill (as indicated in the Part of ReFill Package 
column), and there is a valid URL (Internet address) for this ReFill, you can 
download the ReFill directly from this dialog (provided you have a working Inter-
net connection):

1. Select the sound(s) that use the ReFill.
You should only select several sounds if they use the same ReFill.

2. Click the Download ReFill button.
This launches your Internet browser and takes you to the URL associated 
with the ReFill.

3. A dialog appears, asking you to download the ReFill and place it in 
one of the database folders. Do so.

4. Click OK.
Reason automatically scans the downloaded ReFill and locates the files.

Proceeding

At any point, you can click the OK button to close the dialog and open the song 
or patch. Note:

D For the files you have found (status “Replaced”), the new paths will 
be stored in the song or patch.
However, you need to save the song or patch for the changes to become 
permanent!

D If any file is still missing when you click OK, there will be sounds 
missing in the song/patch.
Sometimes, you may want to proceed with sounds missing, and then remove 
or replace the sounds from the device panels in the rack instead.

On the device panels, missing samples are indicated with an asterisk (*) before the file 
names:

Clicking Cancel will abort the operation, i.e. the song or patch will not be 
opened.
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What are Patches?
A Reason patch contains settings for a specific device. As explained in the 
chapter “The Browser”, patches can either be separate files on your hard disk or 
files embedded in a ReFill.

Seven device types use patches:
D Subtractor & Malström synth patches contain all settings on the de-

vice panel.
Selecting a patch brings up a new sound, just like when selecting programs 
or patches on a hardware synthesizer.

D NN19 & NNXT sampler patches contain information about which 
samples are used and their settings (key mapping, tuning, etc.), 
plus the parameter settings on the device panel.
It is important to note that the sampler patch doesn’t contain the actual sam-
ples - only information about which sample files are used.

D Redrum drum computer patches contain a complete “drum kit”, that 
is, information about which drum samples are used, together with 
the parameter settings for each drum sound.
Again, the actual samples are not included in the patch, only file references. 
Also note that Redrum patches are separated from Redrum patterns - se-
lecting a new patch will not affect the patterns in the device.

D Scream 4 and RV7000 effect patches contain all settings on the re-
spective device panel.
Selecting a patch brings up a new sound, just like when selecting programs 
or patches on a hardware effect device.

! Patches do not include information about any routing done on the 
back of the device.

Selecting a Patch
To select a patch for a device, use one of the following methods:

D Click the folder button in the Patch section on the device panel.

! Note: On the panels of the Redrum, NN19 and NNXT devices, there 
are also other folder buttons, used for loading samples. Make sure 
you click on the button in the Patch section (next to the patch name 
display)!

D Select the Browse Patches item on the Edit menu or device context 
menu.
Note that the Edit menu reflects which device is selected - in other words, 
you must select the device for the corresponding Browse Patches item to 
appear on the Edit menu.

In both cases, the Browser dialog appears, allowing you to locate and select the 
patch, on the hard disk or within a ReFill. See page 80 for details about the 
Browser.

D Once you have selected a patch, you can step between all the 
patches in the same folder by using the arrow buttons on the device 
panel.
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D If you click on the patch name display on the device panel, a pop-up 
menu will appear, listing all patches in the current folder.
This allows you to quickly select another patch in the same folder, without 
having to step through each one in turn.

When you select a patch, the device’s parameters will be set according to the 
values stored in the patch, and the name of the patch will be shown in the patch 
name display. As with any change you make, this operation can be undone (see 
page 39).

! Any parameter adjustments you make on the device panel after se-
lecting a patch will not affect the actual patch file (for this you need 
to save the patch - see below).

If referenced samples are missing
As described above, patches for the Redrum, NN19 and NNXT contain refer-
ences to samples. Just like patches, samples can be independent files on the 
hard disk or elements within a ReFill. However, if sample files have been moved 
or renamed after a patch was saved, the sample file references in the patch will 
not be accurate.

If this is the case when you select a patch, the program will tell you so. You can 
then choose to either manually locate the missing files, to have the program 
search for them in the database and ReFills or to proceed with missing sounds. 
For details, see page 81.

! Proceeding without locating or replacing the missing samples re-
sults in silent drum sounds and key zones (for the Redrum and 
NN19/NNXT, respectively).

Saving Patches
Saving device settings in a song
When you save a Reason song, all settings for all devices are automatically in-
cluded in the song file - there is no need to save the patches separately.

! It’s important to realize that it’s the actual settings that are saved in 
the Song - not references to patches on disk. The next time you 
open the song, all devices will be set as they were when you saved 
(regardless of whether you have removed or edited any patches on 
disk).

Saving device settings as patches on disk
Even though the device settings are stored in the song, you may want to save 
any settings you have made for a device as a separate patch file. This allows you 
to use the patch in other songs, and lets you try out other patches in your song 
without risking to lose your sound.

1. Click the floppy disk button on the device panel.

✪ You can also select a device and use the Export Patch command on 
the File menu.

2. In the file dialog that appears, specify a location and name for the 
patch file and click Save.

D Under Windows, the different types of patch files have different file 
extensions.
These are “.zyp” (Subtractor patch files), “.xwv” (Malström patch files) 
“.smp” (NN-19 patch files), “.sxt” (NN-XT patch files) and “.drp” (Redrum 
patch files). 
Under Windows, file extensions are automatically added by Reason when 
you save. Under MacOS, you can choose to automatically add extensions by 
activating the “Add Extension to File Name” checkbox in the save dialog (this 
is not required, but may be a good idea if you want the saved files to be us-
able under Windows).
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D If you have selected a patch, modified it and want to save it with the 
modifications, you could either save a separate, modified version of 
the patch (with a new name) or simply overwrite the old patch file 
on disk.
As usual, you will be asked whether you really want to replace the existing 
patch file. 

! Note that you can save a patch under the same name and location 
without having the save dialog appear by holding down [Option] 
(Mac)/[Alt] (Windows) and clicking the floppy disk button on the 
device panel. Be aware that this overwrites the original patch!

! Note also that you cannot save into a ReFill! This means that if you 
have opened a patch from within a ReFill, modified it and want to 
save it, you need to save it as a separate file. Preferably, you should 
also rename the modified patch file, to avoid confusion.

Copying and Pasting 
Patches between Devices
A quick way to transfer settings between devices of the same type is to use the 
Copy and Paste Patch functions. The result is exactly the same as if you had 
saved a patch on one device and opened this patch on another device - this is 
just a quicker method.

! Copying and Pasting settings is possible with all instrument device 
types, except the Dr. Rex Loop Player.

Proceed as follows:

1. Select a patch, and/or make the desired settings on the first device.

2. Select Copy Patch from the device context menu or the Edit menu.

3. Select the other device of the same type (in the same song or an-
other song).

4. Select Paste Patch from the device context menu or the Edit menu.
The settings of the first device (including Redrum and NN19/NNXT sample 
references) are applied to the second device.

! Note that this operation simply copies the settings from one device 
to another. Adjusting the settings on one of the devices will not af-
fect the other; neither are the settings connected to any patch file 
on disk.

Initializing Patches
Sometimes it is useful to start with a “clean slate” when creating a synth sound, 
a drum kit or a sampler patch. This is done by selecting Initialize Patch from the 
device context menu or Edit menu. This sets all parameters to “standard” values. 
Initializing NN19, NNXT, Dr. Rex or Redrum devices will also remove all sample 
file references, allowing you to start from scratch.
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About Self-contained 
Songs
The song is the main file format in Reason. A song contains the device setup and 
all settings in the rack, as well as everything you have recorded in the sequencer.

However, this is not always sufficient! Should you open your song on another 
computer or send it to another Reason user, you would also have to bring all 
samples and REX files used by the devices in the song. To make this easier, 
Reason allows you to create “self-contained” songs.

A self-contained song contains not only the references to the used files, but also 
the files themselves. You can choose exactly which files should be included in 
the self-contained song, with the following exception:

! Files that are part of a ReFill cannot be included in a self-contained 
song.

If your song contains samples or REX files from a ReFill, other users must have 
the same ReFill to be able to play the song.

To specify which files should be included in the song, proceed as follows:

1. Pull down the File menu and select Song Self-Contain Settings...
A dialog appears, listing all samples and REX files used in the song.

2. Tick the checkbox in the Sound column for the files you want in-
cluded in the song.

D You can use the Check All button to activate all checkboxes in one 
go.
Similarly, the Uncheck All button deactivates all checkboxes.

D Files that are part of a ReFill are indicated by a lock symbol instead 
of a checkbox (since they cannot be included in the song file).
The rightmost column indicates to which ReFill each such file belongs.

3. When you have selected the desired sounds, click OK.
The dialog is closed. The next time you save, the specified sounds will be in-
cluded in the song file.

! Note that a self-contained song file will be considerably larger than 
the original song file. 
However, samples included in a self-contained song are automati-
cally compressed by approximately 50%, meaning that the self-con-
tained song will still be a lot smaller than the original song and the 
sample files combined.

“Un-self-containing” a Song
If you have opened a song that is more or less self-contained (i.e. contains one 
or several sounds embedded in the song file), you may want to extract these 
sounds and make the song refer to them on disk as usual. This is done in the fol-
lowing way:

1. Select Song Self-Contain Settings from the File menu.
The dialog appears.

2. Locate the sounds you want to extract from the song file, and deac-
tivate their checkboxes (or click Uncheck All).

3. Click OK to close the dialog.
Now, the program will check for each “extracted” sound file whether it is 
available in your database (at its original, stored location) or not.

D If the program finds the sound file at the location stored in the 
song, it is simply removed from the song file, and the original file 
reference path is used.
This would be the case if you made the song self-contained yourself, and un-
self-contain it on your own computer (provided that you haven’t removed the 
original sound files from disk since you made the song self-contained).

D If the program doesn’t find the sound file, a file dialog appears, al-
lowing you to select a folder and name for the sound file.
The extracted file will be saved in the specified folder, and the path in the 
song will be adjusted. This would be the case if you got the self-contained 
song from another user, for example.
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Song Information
Selecting the Song Information item on the File menu opens a dialog in which 
you can supply various information about the song. 

For example, if you plan to send the song to other Reason users, this dialog al-
lows you to add contact information, comments about the song, etc. Further-
more, if you save a published version of the song in the Reason Song Archive on 
the Propellerhead web site (see page 92), vital information can automatically be 
extracted by the web archive engine, and displayed with the song file.

The dialog contains the following items:

Text in Window Title

The text you add here will be displayed directly after the file name in the song 
window’s title bar.

More Information

This is where you add notes and comments about the song.

Song Splash

Allows you to add a picture to the song. If the “Show splash on song open” 
checkbox is ticked, the picture will be displayed when the song is opened.

To add a splash picture, click the folder button at the upper right corner, and lo-
cate and open the picture file in the file dialog that appears.

! Splash pictures must be JPEG files (Windows extension “.jpg”) with 
a size of 256 x 256 pixels.

To remove the splash picture from the song, click the cross button.

Author’s Web Page

Allows you to specify your web site. The user can go directly to your site by 
clicking the Browser button to the right (provided he has a working Internet con-
nection).

Author’s Email

This is where you specify your email address, if you want other Reason users to 
send you their comments, etc.
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Saving a Song
To save a song, proceed as follows:

1. Set up the self-contained settings as desired (see the previous 
page).

2. Pull down the File menu and select Save (or press [Command] / 
[Ctrl]-[S]).
If this is the first time you save the song, a regular file dialog will appear.

3. Specify a name and location for the song and click Save.

Once you have saved a song, selecting Save will simply save it under the same 
name and in the same location, without showing a dialog. If you want to save a 
song under another name or in another location, select Save As... from the File 
menu to open the save dialog.

Publishing a Song
If you want to make your songs available to the public, e.g. for downloading on 
the Internet, there is a special file format for this. A Reason published song (Win-
dows file extension “.rps”) is much like a self-contained song, but has the follow-
ing restrictions:

• The user cannot save any changes to the song.
• Copy, Cut and Paste is disabled.
• It is not possible to use the function Export Song/Loop as Audio File if the 

the song has been changed in any way.

In a word, published songs are “locked”. They are meant for playback only - no 
elements can be added, removed or extracted. Furthermore, a published song 
contains information about which ReFills are required (if any).

To create a published song, pull down the File menu and select Publish Song. 
Specify a name and location for the published song in the file dialog that ap-
pears, and click Save.

D Note that you don’t have to make self-contained settings - all files 
(except ReFill components) are automatically included.

About the Reason Song Archive

On the Propellerhead web site (www.propellerheads.se) you will find the Rea-
son Song Archive. This allows you to share your music with other Reason users 
by uploading your songs. 

Opening a Song
1. Pull down the File menu and select Open.

The Reason song browser window appears.

2. Use the browser to navigate to the desired folder on disk or within a 
ReFill.
See page 80.

3. When you have located the song file, select it and click Open (or 
double click on the file).
The song appears in its own document window.

✪ You can have several songs open at the same time if you like. This 
allows you to copy and paste patterns and patches between songs. 
However, all open songs consume some memory and performance, 
so you may want to close songs you don’t need.

If the “Missing Sounds” dialog appears
If the song includes samples or REX files, and these have been moved or re-
named since the song was saved, the program will inform you that it cannot find 
all files. You can then choose to either manually locate the missing files, to have 
the program search for them in the database and ReFills or to proceed with 
missing sounds. For details, see page 82.

Closing a Song
To close the current song, select Close from the File menu or click the close box 
of the song document window. If you have unsaved changes, you are asked 
whether you want to save the song.
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Creating a New Song
To create a new song, select New from the File menu. This makes a new song 
document window appear.

D By default, the new song will contain a predefined set of instrument 
and effect devices, along with a mixer.
If you want to start with your own selection of devices (or an empty rack), 
you can customize your default song, as described below.

✪ An alternative to creating a new song would be to open one of the 
templates found in the Template Songs folder (within the Reason 
program folder).

Creating a Default Song
If you often start off with the same set of devices, patches, patterns and settings, 
you may want to create your own custom default song. Proceed as follows to 
specify a song as the default:

1. Select New from the File menu to create a new song document win-
dow.

2. Add/remove devices and make settings as desired.
Typically, you may want the default song to contain your choice of devices 
and possibly some patterns. You could also make some special routing be-
tween devices, or even add some sequencer data.

3. Save the song anywhere you like, and under whatever name you 
like (to keep things organized you might want to save the song in 
the Reason program folder).

4. Open the Preferences dialog from the Edit menu (or from the Rea-
son menu, if you are using Mac OS X).

5. On the “General” page, click the radio button to select “Custom” in 
the section called “Default Song”.

6. Click the folder icon to the right to open the file browser.

7. Navigate to the song you created earlier, select it and click “OK”.
The name of the song appears in the textbox.

8. Close the Preferences dialog.
The next time you launch the program or select New from the File menu, the 
new song document will contain the devices and settings you made.
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Exporting as an Audio File
When you have created a complete song, you may want to mix it down to make 
it playable for other people (who don’t use Reason). Of course, you could con-
nect the audio outputs of your audio hardware to a tape recorder or similar, and 
simply record the song. But if you are planning to burn an audio CD or create 
mp3 files, it’s much more convenient to mix down to an audio file, using the Ex-
port functions. 

You can either export the whole song (from the start to the “E” marker), or only 
the loop (the area between the left and right locator in the sequencer). Proceed 
as follows:

1. Make sure only the main stereo outputs are used.
That is, no devices should be connected to individual outputs (output socket 
3 and higher in the Hardware Interface device). The export function will only 
include audio routed to the stereo outputs.

2. Make sure the Loop/End markers are at the correct positions.
If you want to export the loop, you need to set the left and right locators to 
encompass the desired area. If you instead want to export the whole song, 
make sure the End (E) marker is at the desired end position.

The E marker informs the program of where the song ends.

✪ If you are using reverb or delay, you may want to adjust the right lo-
cator or End marker so that the reverb/delay “tails” are included in 
the exported file.

3. Check that the song (or loop) plays back properly.
It’s especially important that no clipping occurs during playback (see page 
46).

4. Pull down the file menu and select Export Song as Audio File (or 
Export Loop as Audio File).
A file dialog appears.

5. Specify a name, location and file type (AIFF or Wave) for the audio 
file, and click Save.
This opens a Settings dialog.

6. Use the pop-up menus to select a sample rate and bit depth (reso-
lution) for the audio file.
16 or 24 bit audio is supported, at a number of different sample rates. The 
exported file will always be a stereo audio file.

✪ Which format to select depends on how you are planning to use the 
file. If you are planning to burn an audio CD, you should select 16 
bit, 44100 Hz. If you are planning to open the file in another applica-
tion, you should select a format supported by this application. Also 
note that the higher the resolution and sample rate, the larger the 
file.

7. Click OK.
The program creates the audio file. Depending on the length of the song/
loop, this may take a while, during which a progress dialog is shown.

! If you are using ReWire, you may want to use the Export function in 
the ReWire master application instead. This allows you to include 
audio from both applications in the exported audio file.
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